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| Overview

Device Manager is a device management application that lets you manage Allied Telesis'
hubs, switches and routers using Simple Network Management Protocol (SNMP). You can
perform various operations on the devices from an intuitive graphical user interface. Since
Device Manager is written in Java, it runs on multiple platforms, including Windows, Solaris
and HP-UX, and provides a common look and feel on all supported platforms.

Device Manager can be used with an integrated network management platform such as HP
OpenView or as a standalone application.

This User's Guide describes the functions and operations common to all managed devices.
For device-specific operations, please refer to the ATl Device Management Guide.

Topics:

e Starting Device Manager
¢ Main Window

o Basic Operations

¢ Common Menus

o MIB Variable Window

« RMON

| Overview
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2 Starting Device Manager

Device Manager can be started in two ways, from the command line or from a network
management application.

When started, Device Manager identifies the target device after you enter its IP address.
Device Manager will then display the main panel of that device.

Note - In Windows environments, Device Manager can also be launched from the Start
menu or from the Run command in the File menu.

Topics:

e Starting From the Command Line
e Starting From a Network Management Application

2 Starting Device Manager
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2.1 Starting From the Command Line

The command line interface is the most basic way to start Device Manager.
Topics:

¢ Command Syntax
e Target Host

o SNMP Version

o Get Community

o Set Community
e Trap Community

o Titlebar String
e User Account Name

e Security Level

¢ Authentication Protocol
¢ Authentication Password
e Privacy Protocol

e Privacy Password

e Trap Version
o Parameter File

2.1.1 Command Syntax

To start Device Manager from the command line, use the following syntax.

devicemanager [options]

You can specify the following options:

TargetHost
Target host's IP address or DNS host name.

SnmpVersion
SNMP version to be used.

GetCommunity
SNMP Get community string. This is used when retrieving MIB values.

SetCommunity
SNMP Set community string. This is used when modifying MIB values.

TrapCommunity
SNMP Trap community string. This is used when receiving Traps from agents.
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DisplayName
Titlebar string.

UserName
User account name to be used for accessing the MIB. This is required when using
SNMPv3.

SecLevel
Security level that is configured for the User Name. This is required when using
SNMPv3.

AuthProtocol
Authentication protocol that is configured for the User Name. This is required when
using SNMPv3.

AuthPassword
Authentication password that is configured for the User Name. This is required

when using SNMPv3.

PrivProtocol
Privacy protocol that is configured for the User Name. This is required when using
SNMPv3.

PrivPassword
Privacy password that is configured for the User Name. This is required when using
SNMPv3.

TrapVersion
SNMP Trap version to be used.

2.1.2 Target Host
The target host can be specified by entering the IP address of the device or its host name.

Examples:

devicemanager -TargetHost 172.16.99.123

devicemanager -TargetHost dvemgrhub

2.1.3 SNIMP Version

The Device Manager can use SNMPvI, SNMPv2c and SNMPv3. You may specify a value of I,
2 or 3. If the SNMP Version is not specified, the default value of | (SNMPvI) will be used.
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devicemanager -TargetHost 172.16.99.123 -SnmpVersion |

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 2

2.1.4 Get Community
Get Community is an SNMP community string used to get MIB values from the agent. You
must specify the same community string as the one configured on the target host. If the

string is not specified, the default community string "public” is used.

Examples:

devicemanager -TargetHost 172.16.99.123 -GetCommunity getdvemgr

devicemanager -TargetHost dvemgrhub -GetCommunity getdvemgr

2.1.5 Set Community
Set Community is an SNMP community string used to change the values of the agent's MIB
variables. You must specify the same community string as the one configured on the target

host. If the string is not specified, default community string "private" is used.

Examples:

devicemanager -TargetHost 172.16.99.123 -SetCommunity setdvemgr

devicemanager -TargetHost dvemgrhub -SetCommunity setdvemgr

2.1.6 Trap Community

Trap Community is an SNMP community string used to receive traps from the agent. You
must specify the same community string as the one configured on the target host. If the
string is not specified, the default community string "public” is used. If the Trap Community
is explicitly defined, the trap will be enabled automatically.

Example:

devicemanager -TargetHost dvemgrhub -TrapCommunity trapdvemgr
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You can specify a string to display on the titlebar.

Example:

devicemanager -TargetHost dvemgrhub -DisplayName dvemgr

2.1.8 User Account Name

If you specified 3 (SNMPv3) for the SNMP Version, you must also specify a User Account
Name that is already configured on the target host.

Examples:

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView -SecLevel noAuthNoPriv

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView| -SecLevel authNoPriv -AuthProtocol SHA
-AuthPassword PASS1233

2.1.9 Security Level
If you specified 3 (SNMPv3) for the SNMP Version, you must also specify a Security Level
that is configured for the User Account Name on the target host. The available Security

Levels are noAuthNoPriv, authNoPriv, and authPriv.

Examples:

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView -SecLevel noAuthNoPriv

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView| -SecLevel authNoPriv
-AuthProtocol SHA -AuthPassword PASS1233

2.1.10 Authentication Protocol

If you specified 3 (SNMPv3) for the SNMP Version, and your Security Level is authNoPriv or
authPriv, you must specify an Authentication Protocol that is configured for the User
Account Name on the target host. The available Authentication Protocols are MD5 and
SHA.
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devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView -SeclLevel authNoPriv
-AuthProtocol MD5 -AuthPassword PASS1234

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView| -SecLevel authNoPriv
-AuthProtocol SHA -AuthPassword PASS1233

2.1.11 Authentication Password
If you specified 3 (SNMPv3) for the SNMP Version, and your Security Level is authNoPriv or
authPriv, you must specify an Authentication Password that is configured for the User

Account Name on the target host.

Examples:

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView -SeclLevel authNoPriv
-AuthProtocol MD5 -AuthPassword PASS1234

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView| -SecLevel authNoPriv
-AuthProtocol SHA -AuthPassword PASS1233

2.1.12 Privacy Protocol
If you specified 3 (SNMPv3) for the SNMP Version, and your Security Level is authPriv, you
must specify a Privacy Protocol that is configured for the User Account Name on the target

host. The available Privacy Protocol is DES.

Examples:

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView -SecLevel authPriv
-AuthProtocol MD5 -AuthPassword PASS1234
-PrivProtocol DES -PrivPassword PASS5678

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView| -SecLevel authPriv
-AuthProtocol SHA -AuthPassword PASS1236
-PrivProtocol DES -PrivPassword PASS5675
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If you specified 3 (SNMPv3) for the SNMP Version, and your Security Level is authPriv, you
must specify a Privacy Password that is configured for the User Account Name on the
target host.

Examples:

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView -SecLevel authPriv
-AuthProtocol MD5 -AuthPassword PASS1234
-PrivProtocol DES -PrivPassword PASS5678

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView| -SecLevel authPriv
-AuthProtocol SHA -AuthPassword PASS1236
-PrivProtocol DES -PrivPassword PASS5675

2.1.14 Trap Version

The Device Manager can use SNMP vl, v2c, v3 traps or all versions of SNMP traps. You
may specify a value of 1, 2, 3, or 4. If the SNMP Trap Version is not specified, the default
value of | (vl) will be used. If the Trap Version is explicitly defined, the trap will be enabled
automatically.

Examples:

devicemanager -TargetHost 172.16.99.123 -TrapVersion 2

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 2 -TrapVersion 4

If you specified 3 (v3) for the SNMP Trap Version, the SNMP Version that must be specified
is SNMPv3 also with additional SNMPv3 parameters. You can also combined SNMPv3
parameters with any trap versions.

Examples:

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView -SecLevel noAuthNoPriv -TrapVersion 3

devicemanager -TargetHost 172.16.99.123 -SnmpVersion 3
-UserName AlliedView| -SecLevel authNoPriv -AuthProtocol SHA
-AuthPassword PASS1233 -TrapVersion |
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Option parameters can be written in a file and can be used by Device Manager to access the
device. The parameter file is a plain text file which contains a name-value pair on each line.

Example:

devicemanager -TargetHost H3600 @paral.txt
where paral .txt is:

-SetCommunity set
-GetCommunity get
-Displayname TEST

2 Starting Device Manager
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2.2 Starting From a Network Management Application

Device Manager can be started from an integrated network management application.
Topics:

o Starting From Castle Rock SNMPc

o Starting From HP OpenView Network Node Manager
o Starting From IBM Tivoli NetView

e Starting From Ipswitch WhatsUp
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To start Device Manager from SNMPc, double-click on a node icon on the map window. If
the node is supported by Device Manager, the main panel of the node is displayed.

Note that Device Manager and SNMPc run independently of each other, so exiting SNMPc
has no effect on Device Manager. Device Manager continues to run even after SNMPc stops
running. To exit Device Manager, select Exit from its File menu.
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Map [Mb | Trend| Event| - .

Far Help, press F1 Incalhast \Administrator  [Supervisor 2
Starting from SNMPc

Note - SNMPv3: In order to start Device Manager in SNMPv3 mode, the node's Read/Write
Access Mode attribute should be set to SNMP V3 No-Auth, SNMP V3 Auth-MD5, SNMP V3
Auth-SHA, SNMP V3 Priv Auth-MD5, or SNMP V3 Priv Auth-SHA, depending on the SNMPv3
settings configured on the target device.
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2.2.2 Starting From HP OpenView Network Node Manager
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To start Device Manager from HP OpenView, select a node on the map window, then

select AlliedView-EMS > Device Manager from the Tools menu.

Note that Device Manager and HP OpenView run independently of each other, so exiting
HP OpenView has no effect on Device Manager. Device Manager continues to run even
after HP OpenView stops running. To exit Device Manager, select Exit from its File menu.

L£1192.168.10.5egment1

=10l x|

Map Edit Miew Performance Configuration Fault | Tools Options  Window  Help

A | | 40 |08

Rapicr 16F IMT)

‘web Browser

DML Browser:
Views

9z 166.10.163 - [=

n Report Presenter
mganl Remate Power On

Terminal Connect: Telnet
Unused IP Addresses
HF Opentiew Launcher
+ Pork-address Mapping
@ Data Warehouse

f SMMP MIE Browser

e W
AVE Allied Telesis

Device Manager

BTG

T e

AT-5H410

AT-FHE00W

default [Read-Write] | [Auta-Layout] [Connection Labels OFF]

Starting from HP OpenView

Note - The configuration of HP OpenView changes during the installation of AlliedView-EMS

to incorporate Device Manager and AMIGO in its menu.

Note - For the AT-AR255E running firmware v1.0.2, HP OpenView sets the host name to
“RIP2-ROUTERS.MCAST.NET”. Device Manager, when started within HP OpenView, uses
this host name and connects to any RIP2 router present in the network. As a result, Device
Manager may not load the AT-AR255E device panel and may instead load another device’s
image. To prevent this from happening, create one entry in the local hosts file for each AT-
AR255E running firmware v1.0.2 in the network. Use the LAN IP address of the device and

a host name that is unique within the network.
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Note - HP-UX : When manually adding an AT-AR255E running firmware v1.0.2 to the
network map in HP OpenView, use the device’s host name, as specified in the local hosts
file, for the Hostname field in the IP Map dialog. Using the device’s IP address instead of its
host name will reset the Hostname field to “RIP2-ROUTERS.MCAST.NET” causing Device
Manager to connect to any RIP2 router present in the network when started within HP
OpenView.

Note - HP OpenView can only start Device Manager in SNMPv| mode.
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2.2.3 Starting From IBM Tivoli NetView

To start Device Manager from Tivoli NetView, select the device that you want to connect
to then choose Tools > AlliedView-EMS to start Device Manager.

Note that Device Manager and Tivoli NetView run independently of each other, so exiting
Tivoli NetView has no effect on Device Manager. Device Manager continues to run even
after Tivoli NetView stops running. To exit Device Manager, select Exit from its File menu.

default - Tivoli Met¥iew [Basic Menu] - [IPMap - Segment:192.168.10.5¢ - |I:I|5|
t" File Edit ©Object Submap Wiew Monitor Test | Tools ©Options Window Help - |5’ |5|
" - o— | g MIE 3
Find - ﬁ. o _E. @ = J &
I[ ) J | | | | 2 —  web Device Mamt  *

CMAT Operations Pk

P Telnet
Root |

162.10.101] [19216810.108] [192.163.10.1

1
»

IF Irnke- z &
(as (s
1921k [19216810114] [192168.10.116] [192168.10116] [19216810.13]

L2
LR
»

165.10.26]  [19216210.37 [192162.10.38) [192162.10.42] [192162.10.43] [192162.10.47]

a2
&

P

i

[=]
192.16- =
Ml
192,165, 10,108 - = 192,163,10,105 [Nodes: 125 R [Zoom 2 1.5 [14:27 FM w

Starting from Tivoli NetView

Note - The configuration of Tivoli Netview changes during the installation of AlliedView-EMS
to incorporate Device Manager and AMIGO in its menu.

Note - Tivoli NetView can only start Device Manager in SNMPv| mode.
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2.2.4 Starting From Ipswitch WhatsUp

To start Device Manager from Ipswitch WhatsUp, right click on the device you want to
connect to then choose AlliedView-EMS Device Manager.

Note that Device Manager and Ipswitch WhatsUp run independently of each other, so
exiting Ipswitch WhatsUp has no effect on Device Manager. Device Manager continues to
run even after Ipswitch WhatsUp stops running. To exit Device Manager, select Exit from

its File menu.

[ Ipswitch WhatsUp Professional 2006 - [Network Explorer - Snmp5scan (Z006=0571
[] File Edit Yiew Arrange Corfigure Tools Reports ‘Wwindow Help

=10l x|
=8| x|

B g5 a)las @3] me|H D

" SnmpScan (2006-05-02 15:45:16)

'Es Device Groups

_ﬁ Device Types [Basic)
] Device Types [Advanced

o
:

A >
oy

bzcend
Pipelire

e o

ATl Device  AT| Device

Appla-D avice

Cizco Device

Dr-Link, HF Device
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# BcE

Copy

Paste
Delete

\EI.OIEEILA”'

L

Display

92 168.1
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-
192.168.10.1
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v Device Wiew Ii
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Lirk,
Set Dependencles

V
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Pall Maw
Acknowledge

SPMP Wigtal

Device Reports. ..
Group Reports. ..

& Traceroute
5 Ping

4 Conneck

3 Browse

1 Aliedview-EMS AMIGO

2 aliedview-EMS Device Manager

Remote Desktop. ..

Bulk Field Change
Device Status Repaort...
Properties

P

L
168.10.27
¥

Starting from WhatsUp

Note - Ipswitch WhatsUp can only start Device Manager in SNMPvI| mode.

2 Starting Device Manager
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3 Main Window

When started, Device Manager displays one of the following windows, depending on how it
is started.

Topics:

e Initial Window
e Panel Window

3 Main Window
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3.1 Initial Window

If the target host is not specified, or specified SNMP settings don't match those configured
on the host, the following window appears.

Device Manager 2 =10O] x|
File Wiew Option Tool User Menu Help

| |0 ] =] | | ) B 0| @ ] 2
| |

Initial Window

To specify a target host from this window, select File > Open. When Device Manager can
identify the host, the panel window displaying the product front panel will appear.

3 Main Window
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3.2 Panel Window

e
Allied Telesis

When the target host is specified and Device Manager can identify the host model, the

following window appears.

" 192.168.10.85 - Device Manager for AT-8624T/2M =10O] x|
File ‘iew Option Agent Routing Brdge Port Tool UssrMenu Hslp
ELEEEC TR
AT Alied Telesls AT-8624TI2M
- BUPLER
o 1] 1BBASET/ 1BBBASETE y GRS LA T
I EFEEEELEIEELEE | [eeap—
o] ] (oW N N o N o | oI ol ol o o- o F-'I B
L-'\i'NB{J QM
System Marne: System Description:
AT-G524T 120 llied Telesis AT-8624T/2M version 2.9.1-04
Sy stam Location: Z6-Feh-2007
ATP Lab
System Cortact
Alied Telesis
i Connect |

Panel window

The menu bar includes items specific to the product model, in addition to the menu items

common to all models.

Some elements such as network ports also act as menus. When you click on a port, a pull-
down menu appears. Select these menu items in the same way as from the menu bar, where

they can also be selected.

Refer to the ATl Device Management Guide for device-specific menu items.

In the panel window, the lower half of the window displays information about the target
agent, showing values of the MIB-Il system group variables. If you change the size of the

window, it will open at the new size the next time it is used.
Topics:

e System Name
e System Location

¢ System Contact
o System Description
e Status Bar
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3.2.1 System Name

AVE Allied Telesis

Usually, the System Name is set to a unique descriptive name for identifying the device. This
refers to the MIB object sysName.

Note - SNMPv3: Depending on the READ VIEWV access settings of the user name, there is a
possibility that the System Name will not be displayed.

3.2.2 System Location

Usually, the System Location is set to indicate where the device is installed. This refers to
the MIB object sysLocation.

Note - SNMPv3: Depending on the READ VIEW access settings of the user name, there is a
possibility that the System Location will not be displayed.

3.2.3 System Contact

The System Contact is set to indicate the name or phone number of the contact person for
the device. This refers to the MIB object sysContact.

Note - SNMPv3: Depending on the READ VIEVV access settings of the user name, there is a
possibility that the System Contact will not be displayed.

3.2.4 System Description

Usually, the System Description is set to to indicate some information about the device
such as model name, software release and version. This refers to the MIB object sysDescr.

Note - SNMPv3: Depending on the READ VIEWV access settings of the user name, there is a
possibility that the System Description will not be displayed.

3.2.5 Status Bar

The status bar is the area at the bottom of the panel window where a brief description of a
highlighted menu option or toolbar button is displayed. The depressed rectangular area at
the right end of the status bar shows the connection state of Device Manager.

3 Main Window
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4 Basic Operations

This chapter describes the basic operations within Device Manager windows.
Topics:

e Click
e OK, Cancel and Set Buttons

e Pop-up Menus
e Resizing Windows

e Resizing Tables

4 Basic Operations
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4.1 Click

Device Manager uses both the left and right mouse buttons. To operate items on the menu
bar, you can use both the left and right mouse buttons. To click on the icons on the toolbar,
use the left mouse button. To open the menus for the device images displayed in the main
Device Manager window, use the right mouse button, then you can use either the left or
right mouse button to select an item in the menu that you have opened.

4 Basic Operations
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4.2 OK, Cancel and Set Buttons

Dialog boxes have buttons to commit or discard changes made in the dialog box.

Clicking the OK button confirms and commits the changes made and closes the dialog box.
If the dialog box has tabs, the OK button commits changes in all the tabs.

Note - Some configuration options are effective only after restarting Device Manager.

Clicking the Cancel button discards the changes made in the dialog box and closes the
dialog box.

Clicking the Set button commits changes immediately without closing the dialog box.

Note - Clicking the Cancel button after the Set button cannot undo any changes.

4 Basic Operations
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4.3 Pop-up Menus

Some elements such as network ports also act as menus. When you right click on a port, a
pull-down menu appears. Select these menu items in the same way as from the menu bar,
where they can also be selected.

192.168.10.85 - Device Manager for AT-8624T/2M o N [m] ]
Fils ‘“iew Option #&gent Routing Bridge Port Tool Usar Menu Help

SATL Al TEIESE AT-8624T/2M

DUPLEX
FULL DU« HALF DUP

0 : ;L 1B8ASE-T/1008A%ETX

B H E B E L IEE B R E
urn- | W1 I o
sl

" ] (oM oM NN oW ORY oMl S
c

STRIUZ

-

Interface Info

Error Statistics

SREILZLE SHSE Spanring Tree Info

AT-BB24TR2M AT e o— I version 2.9.1-04
System Location: E-Ft g

ATP Lab AL Megatiation Info
System Cortact Enable

Alied Telesis Disable

Connect |
Port

Right clicking on a port displays the menu items specific to the device.

RS-232 Terminal Port
Right clicking on an RS-232 port displays the menu items which allow you to select
how to log in to the device's management interface. Depending on the device type,
Telnet or WEB Browser (HTTP) can be selected.

Reset Button
Right clicking on a reset button displays a menu item that allows you to reset the
device.

4 Basic Operations
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4.4 Resizing Windows

To resize a window, follow the procedures specific to the platform you use. The new
window size is stored when exiting Device Manager, and restored when Device Manager is
restarted. You can also resize the image or fix the display of the image using the Options
window. In the main Device Manager window, click Option > Option to open the Options
window then check the "Image size fixed" option.

| External Cnmmandl =er .ﬂ-miu:unl Otherl

Look & feel: Il/\ﬂndclws LI

Language: IEninsh LI
Toolbar type: Ilmage Oy LI
Display type:

+ Stack Type i~ Tah Type

[ Resize window when the number of stack changed

™ Image size fixed

[ Link-towen as error

(034 | Cancel I

Fixed image size

4 Basic Operations
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4.5 Resizing Tables
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Device Manager displays information in tables. It is possible to resize table boundaries or
field/column boundaries by dragging the borders. To do this, position your pointer on a
table border. When the pointer has transfomed into arrows, left click on the border and
drag it to the right or to the left, depending on whether you want to increase or decrease

the table or field/column.

Example |: Adjusting the MIB Variable column. To do this, position your pointer on the
column border. When the pointer has transfomed into arrows, left click on the border and
drag it to the left while holding the left mouse button to display the other columns.

+ Interface Info{[1-26]) ﬂ
Table | pict chart | Bar chart | Edit | options |
| 5
Port Mumber 1
Port Descrigption 100ME_Ethe...
Port Type B
| AT 1500
Speed 100000000
Phyzical Address 00 30 84 66 ..
Administration Status up
Opetation Status dovwvn
Last Change Time and Date 0 days 0:00; ...
Received Bytes i}
Received Unicast Packets 1]
Received Mon Unicast Packets 1]
Received Discard Packets 1]
Received Error Packets 1]
Received Unknown Protocol Packets 1]
Tranzmitted Bytes i}
Transmitted Unicast Packets 1]
Tranzmitted Maon Unicast Packets 1]
Tranzmitted Discard Packets 0
Transmitted Error Packets 1]
Tran=smitted Buffer Lenigth 0
Specific Media ME MULL
: >

Ex I: Before adjustment
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Table | pict chart | Bar chart | Edit | options |
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Interface Info{[1-26]) x|

| 5
Port Mutnkber 1 2 3 4|
Port Description 100ME_Ethe... | 100ME_Eth... | 100ME_Eth... |1
Part Type [ B [ E
rATL 1500 1500 1500 1
[ Speed 100000000 100000000 100000000 1
Physical Address N0308466 .. (00308466, (00308466, |C
Administration Status up up L L
Opetation Status dowen dovwen dowvr [
Last Change Time and Date Odays 000, | Odays 000, | Odays 0:00.. | O
Received Bytes ] 0 o C
Received Unicast Packets ] 0 o C
Received Mon Unicast Packets u] u] o C
Received Discard Packets 0 0 0 C
Received Error Packets 0 0 0 C
Received Unknown Protocal Packets ] 0 0 C
Transmitted Bytes 0 0 0 C
Tranzmitted Unicast Packets ] 0 o C
Transmitted Mon Unicast Packets u] u] o C
Transmitted Discard Packets 0 0 o C
Transmitted Error Packets 0 0 0 C
Tranzmitted Butfer Length 0 0 0 C
Specific Media ME MULL MULL MULL M

=

A

Ex I: After adjustment
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\..

Example 2: Adjusting the boundary between graph and table. To do this, position your
pointer on the border between the graph and the table. When the pointer has transfomed
into arrows, left click on the border and drag it to the left while holding the left mouse

button to increase the table width.

H Interface InfofifEntry.[1-26])

Table Piot Chiart | Bar chart | Edit | options |
| 2]l )

X

28  |Receiver
28  |Receiver

GO0 .{3 43
4001 14

FREEREREERERERE

®is 30  |Receiver

200 16 31  |Receive

T i ‘--. 17 32 |Receiver

1] *13 33 |Receiver
19 |4 b

1400 *: :l? 3 zpeegtiﬂ

T B pee (! 1
1200 I &7 21 |Speed(il
T f \ g 22 |Speed(if
1000 g 23 |Speed(if
1 /j X /\(;\__\/\ﬁ 1 24 |Speed(if
] /ﬁ\ Sy 25 |speedf
T 26 |Speed(if
2 12 27 |Receiver

-

Ex 2: Before adjustment

H Interface Info{ifEntry.[1-26])

Table Plot Chart | Bar Chart | Edit | Options |
| 2| | o

14 |Speed(ifSpeesd.14)
15 |Speed(ifSpeed.15)

Jﬁ\m 10

<) =) =) ) = R R

F

P ] Speed(ifSpeed.9)
1400 [ B 10 |Speed(ifSpeed.10) =
i Sl (S s el
1000 *4q 13 |Speed(ifSpeed.13)

and ) \ Lo 16 |Speed(iiSpeed.16)
so0—s g1 2 17 [Speed(itSpeed17)
I 13 18 |Speed(ifSpeed.18)
400 14 18 |Spesd(ifSpeed.19)
i ®1s 20 [Spesd(ifSpesd 20)
200 16 21 |Speed(ifSpeed.21]
3 17 22 [SpeediifsSpeed.22)
Dnﬁmn 15 23 |Speed(ifSpesd23) -
ol ri |

Cloze

Ex 2: After adjustment
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Example 3: Adjusting the table boundary. To do this, position your pointer on the right table
border. When the pointer has transfomed into arrows, left click on the border and drag it
to the right while holding the left mouse button to increase the table width.

Interface Info{1) il

Table | piot chart | Bar chart | Ecit | options |

| =l |
_ Part Murnber 1

Paort Description 100KME _Ethe... =]
Part Type G

MTL 1500

Speed 100000000
Physical &ddress 00 30 84 66 ...
Administration Status up

Opetation Status diovwwn

Lazt Chanoe Time and Date | 0 days 0:00:... —
Received Bytes i}

Received Unicast Packets 0

Received Mon Unicast Packe. 0

Received Dizcard Packets 0

Received Error Packets 0 ;I

Cloze

Ex 3: Before adjustment

Interface Info{[1-26]) |

Table | Piot chart | Bar chart | ot | options |

| sl

Part Murmber . 1
[ Port Description 100ME_Ethernet_Port_2 1=
Port Type G
MTL 1:300
Speed 100000000
Physical Address 003054665016
Adminiztration Status up
Opetation Status diovwvn

Last Change Time and Date

O ddaryz 0000:00 030

Received Bytes

Received Unicast Packets

Received Mon Unicast Packets,

Received Discard Packets

Cloze

Ex 3: After adjustment

4 Basic Operations
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5 Common Menus

This chapter describes the menu items common to all Allied Telesis managed devices.

Topics:
o File
e View
o Option
e Tool
o User Menu
e Help

5 Common Menus
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5.1 File

The File menu lets you start and stop managing a device, check the properties of the target
host, or exit Device Manager.

Topics:
e Open
e Reopen
e Close
e Property
o Exit
5.1.1 Open

From the Open menu item, you can specify a target host to manage. When you select File >
Open, the following dialog box appears. To connect to the device, fill in parameters in the
dialog box, then click OK.

Note - This option is not available if Device Manager is already connected to a target host.
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HH select Target Host x|

Target host: [192.168.10.97 | confirm |

SRR Options ~Trap Options
Wersion: v LI “ersioh: |v1 j

[¥ Enahle 'Trap' operation

w1i2e Trap Cammunity Marme

Ipuhlic

~Polling Options

[ Enable periodic device paling Settings |

Current Status

I(EIEy] Trap disable

Ok Cancel

Select Target Host dialog box

Target host
The host name or the IP address of the target host. To see the description of the
host, fill in host name or IP address and click Confirm. To connect to the host, click
OK.

Note - If "v3" is the selected SNMP version and the specified user account has no
READ VIEW access to the System Description OID but has READ VIEWV access to
the System Object ID, clicking on the confirm button will display the message,
"Unable to retrieve system description."

SNMP Options
Version
This drop down list allows you to select the SNMP version to use in managing the
target device.

Note - Before choosing "v2c" or "v3", make sure that the target device you are
connecting to supports SNMP v2c and/or SNMP v3 respectively.
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Settings

If the Version is set to "vI" or "v2c", this button opens the SNMP v1/v2c Settings
window. Otherwise, if the Version is set to "v3", this button opens the SNMP v3
Settings window.

HE SNMP ¥1,/v2c Settings |

Cormmunity Matne

'iZet' Cpetstion: Ipublic

"Set' Operation: Iprivate

024 | Cancel I

SNMP vl Iv2c Settings dialog box

Community name

The community strings to use in performing SNMP operations on the target host.
There are three types of community strings for the SNMP. Be sure to specify strings
which match the ones configured on the target host.

By default, the following strings are used:

for the Get operation
public

for the Set operation
private

H SNMP ¥3 Settings x|

~SMMPw3 Parameters

User &ccount Mame: IAIIiedViEW

Security Level: I.&uth I Prive

Authertication Protocol; IMDS

Authertication Pazsward: I*****H

Privacy Protocal: IDES LI

Privacy Passward: I*******

Ok | Cancel I

SNMP v3 Settings dialog box

User Account Name
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This is the SNMPv3 User Account to be used for accessing the MIB of the target
device. Make sure to specify a User Account that has already been configured on the
target device.

Security Level

This is the Security Level for the User Account Name that you have specified. Make
sure to set the Security Level to be the same as what is configured on the target
device.

These are the available Security Levels:

No Auth / No Priv
This Security Level uses no authentication and no privacy.

Auth / No Priv
This Security Level uses authentication without privacy.

Auth / Priv
This Security Level uses authentication and privacy.

Authentication Protocol

If the Security Level is "Auth / No Priv" or "Auth / Priv", you need to specify an
Authentication Protocol. Make sure to set the Authentication Protocol to be the
same as what is configured on the target device.

These are the available Authentication Protocols:

MD5
Use HMAC-MD5-96 protocol

SHA
Use HMAC-SHA-96 protocol

Authentication Password

If the Security Level is "Auth / No Priv" or "Auth / Priv", you need to specify an
Authentication Password. Make sure to set the Authentication Password to be the
same as what is configured on the target device.

Privacy Protocol
If the Security Level is "Auth / Priv", you need to specify a Privacy Protocol. This is

the available Privacy Protocol:

DES
Use Data Encryption Standard
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Privacy Password

If the Security Level is "Auth / Priv", you need to specify a Privacy Password. Make
sure to set the Privacy Password to be the same as what is configured on the target
device.

Trap Options
Version
This drop down list allows you to select the SNMP trap version to be used in
receiving traps.

Note - Device Manager will only accept "v3" trap version if SNMP version in the
SNMP Options panel is also set to "v3".

Note - Device Manager will only be able to process and display SNMP v3 traps
received from the currently connected device.

Enable 'Trap' operation
To receive traps from a target host's SNMP agent, check this box.

Note - If SNMPc, HP OpenView or Tivoli NetView is running, Device Manager will
not receive any traps. This is because the traps are being intercepted by the
network management application and will never reach Device Manager.

vliv2c Trap Community Name
Specify the community string that will be used for receiving SNMP vI| or v2c traps.
The default string is "public”.

Polling Options
Settings
This button opens the Polling Options dialog box, in which you can change the
polling interval and retry parameters.

H Polling Options x|

~Polling Interval:

Polling Interwal: |3E|| ﬂ % zec  min
Retry:
Tirmeout: IS

E i

Retry times: |2

(034 | Cancel I Default |

Polling Options dialog box

Polling Interval
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Device Manager sends a GetRequest to the SNMP agent at predefined polling
intervals to ensure that it is still connected to the device. If a shorter or longer
interval is required adjust the value in the Polling Interval field accordingly.

The minimum interval is 5 seconds and the maximum is 3600 seconds (| hour). The
default is 30 seconds.

Retry
Configures the SNMP timeout and the number of retries.

Timeout
The number of seconds Device Manager waits before it determines that the
device is not responding. The default is 5 seconds.

Retry times
The number of times Device Manager sends SNMP messages to the agent before
giving up. The default is 2 retries.

Enable periodic device polling
To regularly check the hardware configuration of hot-swappable devices, check this
box. When this is checked, Device Manager checks the hardware configuration at
every polling interval. The Panel window shows any hardware configuration changes
it finds.

If the target device is not hot-swappable, or if you do not expect any hardware
configuration changes, do not check this box. Polling the hardware configuration may
reduce performance.

Note - Device Manager always checks the latest hardware configuration of the target

device when initiating connection. To check the configuration on demand after the
session is established, select View > Refresh.

Current status
Indicates whether or not Device Manager is currently connected to a target device
and whether or not Trap operations are currently enabled.

5.1.2 Reopen

This command can be used to reconnect to a recently accessed device.

5.1.3 Close

Closes the SNMP session with the device and closes the Panel window. To connect to
another device, select File > Open.
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5.1.4 Property
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Change parameters for communicating with the device. The dialog box is identical to the
Select Target Host dialog box used to open a connection. For information on the settings
that can be modified or viewed from this dialog box, see section 5.1.1.

5.1.5 Exit

Terminates connection to the target device and closes the Device Manager application.

5 Common Menus

AlliedView™-EMS 3.1 | Device Manager User’s Guide Page 41 of 130



_—
—

\..

AVE Allied Telesis

5.2 View

Using the View menu, you can determine whether or not to display the Device Manager
toolbar and status bar, view and set thresholds on MIB variables, and view the log.

Topics:

e Toolbar
o Status Bar

e System Info

e Threshold

e Current Log
e Snapshot

o Refresh

-10f x|
File | View Option Agert PRouking Eridge Port Tool UserMenu Help
E? v Toolbar w n ”| Eﬂl ﬂ.l g| ?l
Ay ¥ Status Bar AT-8624TI2M
¥ System Inffia
Threshold - 188ASE-T/ 1908 AZETY L
z’m”;t” "EEEEELE IHNEHEE o B [
R;::sh offi o ol ol ol P e e e s 0- .,- E ‘]
maa’d GM
Sysiem Mame: System Description:
AT-FE24Ti2M llied Telesis AT-86Z4T/ZM version 2.9.1=-04
Systam Location: 26-Feh-2007
ATF Lab
System Cortact
Adied Telesis
! Connect ‘
View menu
5.2.1 Toolbar

Toggles display of the toolbar. The toolbar is the area holding command icons just below

the menu bar. When checked, the toolbar is displayed.

5.2.2 Status Bar

Toggles display of the status bar. The status bar is the area at the bottom of the Device

Manager window. When checked, the status bar is displayed.
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5.2.3 System Info
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Toggles display of system information, namely, System Name, System Location, System
Contact, and System Description.

5.2.4 Threshold

Displays a list of the configured thresholds. You can also create new thresholds or change
the existing thresholds.

The table has the following fields:

o Status - Indicates the status of the MIB variable that Device Manager is monitoring.

e MIB Variable - Name of the MIB variable that Device Manager is monitoring.

e Current Value - Current value of the variable.

e Max Value - Highest value of the variable after Device Manager starts monitoring.

e Min Value - Lowest value of the variable after Device Manager starts monitoring.

e Average Value - Average value of the variable (per second) after Device Manager
starts monitoring.

e Condition - Threshold configured on the variable. If the variable's value exceeds the
threshold, an action is executed. You can configure the type of action to execute in
the User Action tab of the Option menu.

Note - Current, Max, Min and Average values are zero before the first polling. After the first
polling, they all have the same value. Once the threshold is reached, the corresponding row
is highlighted with a red background. Note that thresholds can only be set for MIB variables
of type GAUGE, INTEGER, COUNTER, GAUGE32, INTEGER32, COUNTER32, or
COUNTERG®64.

H pisplay Threshold R

J —JJ|X|I3’|

MIE *arizkle Current ...

ifAcminStatus .1 i i 1] 1|4274579083

Display Threshold
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Add button (Green 'plus' icon)
Adds a new threshold definition.

Remove button (Blue 'X" icon)
Removes the selected threshold.

Edit button (‘note and pen' icon)

Edits the selected threshold.

5.2.5 Current Log

\..

> Allied Telesis

Displays the event log. It records events such as Device Manager start up, reception of
traps, or threshold events.

i pisplay Current Log x|

| 8|
Tirme Kind Cortents |

Thu hay 19 05:42: 32 GMT+D... Target Alliediew-EMS Device Manager starting. ..
Thu hMay 19 05:46:05 GMT+D... Target Target host 192 1681010 opened. ..
Thu May 19 054702 GMWMT+0... |Target Target host 1921651010 closed...
Thu May 19 034713 GMWMT+0... |Target Target host 192165810135 opened...
Thu May 19 034724 GMWMT+D... |Target Target host 192 16310135 clozed...
Thu May 19 05:47. 34 GMT+HD... Target Target host "ATP-LAE-HPOY' opened. ..

Close |

Display Current Log

Save As (‘Floppy disk' icon)
Saves the log as a text file. Specify a filename in the Save As dialog box. Each log
entry is saved as one line. Each field in an entry is delimited by a TAB character.

Clear ('note and eraser' icon)

Clears the log.

Note - If SNMPc, HP OpenView, or Tivoli NetView is running, Device Manager will

not receive any traps. This is because the traps are being intercepted by the
network management application and will never reach Device Manager.
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5.2.6 Snapshot
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Clicking this option in the View menu opens the Start Snapshot window. Use this window
to create an image of the device, as well as tables or charts representing device information,
in HTML format.

Note - If you open the Start Snapshot from the View menu in the main window, you can
only create an image of the main panel.

H start Snapshot X|
File niztme: Is'l.&llied Telesiz\dliedYiew-EMStnpianapshat btrn Browwze. .. |
zelect:

V¥ Main panel

[~ Table data [™ Plot chart
[ Ear chart [ Fie chart

[¥ Reload
Foreground Colar, ————————— Background Color:

. Color selection | Colar selection
Ok | Cancel I

Start Snapshot

File name
Use the '‘Browse' button to select the directory or folder where you want to save
the image and to specify the name of the HTML file. When you click OK, three files
will be created in the directory or folder you've selected: a PNG file, an XML file,
and an HTML file. To display the device image and associated information, use a web
browser to open the HTML file.

Select
Choose the information that you want to save in the HTML file.

Note - Depending on the selections that you make, the following PNG files will be

created:

Selection PNG File
Main Panel snapshot_m#t.png
Plot chart snapshot_p#.png
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Selection PNG File
Bar Chart snapshot_b#.png
Pie Chart snapshot_i#.png
Table Data No .png file is created for table data.

Reload
Mark this option if you want to update the HTML file at a regular interval.

Foreground Color
This enables you to specify the color of the foreground of the HTML file as displayed
on the web browser, including the text and table borders. Click the "Color
selection" button to open the Foreground Color Selection window where you can
choose the foreground color.

Background Color
This enables you to specify the color of the background of the HTML file as
displayed on the web browser. Click the "Color selection" button to open the
Background Color Selection window where you can choose the background color-.

5.2.7 Refresh

Redisplay the Panel window with the latest device information. Use this menu when the
target host is replaced with another device or if the hardware configuration of the target
host changes.

5 Common Menus
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In the Option menu, general preferences for Device Manager can be changed. Although
Device Manager works well with the default configuration, you can customize some aspects

of its behavior.

This menu has only one submenu, 'Option'. Selecting Option > Option opens the Options

dialog box, which has four tabs.
Topics:

e Screen Tab

o External Command Tab
e User Action Tab

e Other Tab

5.3.1 Screen Tab

Controls the appearance of Device Manager.

Screen | External Cnmmandl U=zer .ﬂ-miu:unl Otherl

Look & feel: Il/\ﬂndclws

Language: IEninsh

Toolbar type: Ilmage Oy

Display type:

" Stack Type {* Tah Type

[ Resize window when the number of stack changes

™ Image size fixed

(034 | Cancel I

Screen tab
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Look & feel
Changes how Device Manager windows are displayed. Your options are Windows,
CDE/Motif, and Metal. To put this change into effect, click OK.

Language
Changes the language. English and Japanese are available. If you change this setting,
you must restart Device Manager to put the change into effect.

Note - This feature is not supported in this version of Device Manager.
Toolbar type
Changes the appearance of the toolbar. Choose one of 'Text Only', 'Image Only' or
'Image and Text'. To put this change into effect, click OK.
Display type
Changes the display style for stackable devices. To put this change into effect, click

OK.

Stack Type
Displays all stacked devices in one window.
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£ 192.168.10.61 - Device Manager for AT-8324 =10f %]

File “igw Option Agent Bridge RMONM Port Tool User Menu Help

EnEEE T e

AT Allicd TElEsis AT.8324h
Sl DUPLEX
‘D < TREASE-T A BEBASETX I FULL DUP = HALF DUP

1 E 5 T e il 1= i 7 18 Zi F3
| FEEYEE EEELLEETL o
AT e[| [0 MR 2B O N OO O N o7 o M| | | [m

Q |:'l.u& '.&-‘;- (O MRSTER

Hal (w124
189, - | ATvhin | DR

AL Alizd Telesis AT-8324|

DUPLES
TBEAZE-T A BEBASETX I FULL DUP «HALF DUF

I EEE B
Q

l.‘lalﬂ UL < iLER I

LL L L i

ASVHD QP

5 T E]
1B/ BEERSETY, ‘3- 0- Q- <E=s - STRTUS
AT o ] {2 N O N | B OB O O O O E el [;m_
< HHLF “ -;JJ DIRFS

AT Al Telesis AT-8324)
b DELEX
LA ENZE-T A SBBOSETX I (AL LTS

o[ ofm) [HE
=l E E EELEIEEEEELE L | pemm—m
el P E R E R R E R EFEFE FM[-M

] frd —
@] o [ = o g
1BAEREE-FCIYF il ASYHO (=103
System Name: System Description:
AT-5524 T-8324 w0: AT-525 w2.0.2 Cycle E
System Location:
ATP Lab
System Cortact
ATP Engineering
Connect ‘
Tab Type

Displays each stacked device in a separate tab.

+ 192.168.10.61 - Device Manager for AT-8324 - O] x|
File ‘iew Option Agent Bridge RMONM Port Tool User Menu Help

I nEE A R R

1: AT-8324 | 2 AT.8324 | 3 AT.8324

AT Al TEIEsis AT-8324
< '31 AEASE-T A HDBEATETS I FuLL o - e o
1 =] 5 T El 11 13 = i iE] 21 23
| IFEEEEY EEEEETE [
A || (2 I N O O O oW O O o oM N E | [;;m_
o0 | -
System Marme: System Description:
AT-8324 T-§324 w0; AT-525 v2.0.2 Cycle E
System Location:
ATP Lab
System Contact
ATP Enginesting

Connect |
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Resize window when the number of stack changes
When checked, Device Manager resizes the Panel window according to the number
of stacked devices. If this is not checked, the size of Panel window does not change
even if Device Manager detects a change in the stack configuration.

Image size fixed
When this option is selected, the size of the image in the main Device Manager
window will not change even if the window size is increased.

Link-down as error
When this option is selected, inactive ports are displayed as red ports in the main
Device Manager window, indicating that links to those ports are down. Disabled
ports are displayed as black ports.

Note - The Link-down as error option is not applicable to the following devices:

o AT-AR240E
e AT-AR250E
o AT-AR255E

e AT-RG2I3FX
o AT-RG2I3TX

5.3.2 External Command Tab

Configures application commands used to directly access the device's management interface.
You can specify a telnet client and a web browser to use. The web browser specified here
is also used to view the online user's manual.

TELNET command
Specifies a command line to start the Telnet client. On Windows, "C:\Program
Files\Windows NT\hypertrm.exe /t" may be used. On UNIX, use "dtterm -e telnet".
Make sure that the command is correct by manually executing the command line. To
select a command from the file list dialog box, click Browse.

WEB browser
Specifies the command or file used to start your web browser.
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x|

Screen  External Command | User Action | Gther |

WEE broveser: C:Program Filesinternet Exploreriiexplore exe Erovwwse. ..

TELMET comtnand: C:Program FilesWindowws NThypertrm.exe & Erovwwse. .. |

Ok | Cancel I

External Command tab
5.3.3 User Action Tab
In the User Action tab, you can specify the action to take when an event occurs. There are

three types of events: an SNMP command timeout, a threshold event, and the reception of
a trap.
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HH Options x|

~Tirneout:

i+ Popup message

 Command Browse...

~Threshaold:

i+ Popup message

" Command Browwse...

—Trap:

i Popup message

i~ Command Erowwse. ..

.

(034 | Cancel I

User Action tab

You can choose an action for each event type. There are two types of actions.

Popup message
Device Manager displays a popup window when an event occurs.

Command

Device Manager executes a predefined command line when an event occurs. You

can use the following special arguments in the command line. They are automatically
passed by Device Manager.

For all event types
$TARGETHOST

The host name of the device. If Device Manager cannot get the host name
using the address, the IP address is used instead.

$TARGETIPADDR
The IP address of the device.

For threshold events

$MIBNAME
The name of the MIB variable which Device Manager calls.
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$CURRENT
Current value of the variable.
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$MAXVALUE
Highest value of the variable during the monitoring period.

$MINVALUE
Lowest value of the variable during the monitoring period.

$AVERAGE
Average value of the variable during the monitoring period.

$MAXLIMIT
Threshold value configured for the variable.

For trap events
$TRAPHOST
The host name of the device which sent the trap.

$TRAPIPADDR
The IP address of the device which sent the trap.

$GENERICTRAP
The generic trap number.

$SPECIFICTRAP
The specific trap number.

$ENTERPRISEOID
The trap's enterprise OID.

$ENTERPRISENAME
The name of the Trap MIB object. If Device Manager cannot get an object
name, $ENTERPRISEOID is used instead.

$TIMETICKS
The trap's TIMETICKS.

$VAROIDn
The OID of the n" MIB object sent with the trap, where n is a number in the
range | to 9.

$VARNAMEN

The name of the n™ MIB object sent with the trap, where n is a number in
the range | to 9. If Device Manager cannot get a name, $VAROIDn is used
instead.
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The value of the n™ MIB object sent with the trap, where n is a number in

the range | to 9.

5.3.4 Other Tab

In the Other tab, you can configure how MIB variables are displayed and the character
encoding system to use in sending and receiving SNMP data. Note that changes made here
apply to windows which are opened after the change is applied. Windows which are already

open are not affected by the changes.

4 options

Screenl External Cnmmandl U=zer Actioh

~MIB wariable name dizplay type:

IC:::nvert LI
[ omit Dizplay

Sample:

IS':.-'s:tem Description(0)

W The X-axiz dizplay name of the chart and graph iz displayed with the number.

Encoding:

ShMP receive datas encoding: INune LI

ShIMP zend data encoding:

[shitt Jis =]

Ok | Cancel I

Other tab

MIB variable name display type

Choose the display type of the variable name from "Convert", "MIB variable" and
"Both". When you change the setting, sample text is displayed in the "Sample"

textbox.
"Convert" option displays a MIB variable name in English.

Examples:

System Description
System Contact
System Name
System Location
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"MIB variable" option displays a MIB variable name in its original form.

Examples:
sysDescr.0
sysContact.0
sysName.0
sysLocation.0

"Both" option displays a MIB variable name in both English and its original form.

Examples:

System Description (sysDescr.0)
System Contact (sysContact.0)
System Name (sysName.0)
System Location (sysLocation.0)

Omit Display
In the Edit tab of dialog boxes, where MIB variables can be edited, "Stack#.Port#" is
appended at the end of the MIB variable name. If you want to omit this suffix, check
this box.

The X-axis display name of the chart and graph is displayed with the number
When checked, item names on the graph/chart's x-axis are displayed as numbers
instead of variable names. This option may be useful when you view a lot of variables
on a screen.

Encoding
Specifies the character encoding system to use in sending and receiving SNMP data.

SNMP receive data encoding
Specifies the character encoding of the data received from the device. Your options
are None, Auto detect, Shift JIS, JIS, and EUC.

Note - In some cases, Device Manager may not be able to recognize the SNMP data
encoding format received when "Auto detect" is selected. If this occurs, you will
need to specify the appropriate SNMP data encoding format.
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SNMP send data encoding
Specifies the character encoding of the data sent by the device. Your options are
None, Shift JIS, JIS, and EUC.

AVE Allied Telesis

Note - It is advisable to set the encoding option to the default value.

5 Common Menus
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5.4 Tool

From the Tool menu, you can launch external applications such as Telnet, your WEB
browser, the MIB browser AMIGO, or VLAN Manager.

Topics:

e TELNET
o WEB Browser
o MIB Browser

e VLAN Manager
e QoS Manager

=101 %]
File ‘“iew Option Agent Routing Eridge Port 'lnul Usar Menu  Help
- | e |
WEE Browser AT-BE24TIZM
AMIGO
[64 115 . WLAN Manager e ©FULL m.p ~ HALFIDUP:

Q05 Manage
| (ool ol Sl ln_v_n..u ol Ol e Ol Gl I
3 j%’ o o o o O oo O O oW Ol oF | [ 'I[m,

o

System Mame: System Description:

AT-E524T2M llied Telesiz AT-3624T/2M version 2.9.1-04
Systam Location: 26-Feh-2007

ATF Lab

System Cortact
Adied Telesis

i Connect ‘

Tool menu

5.4.1 TELNET

Starts the Telnet application specified in the External Command tab of the Options dialog
box (Option > Option > External Command). This menu item simply starts the Telnet
application with no argument (target host) specified.

Note - To Telnet directly to the target device, click the RS-232 port in the Panel window
and then select Telnet, or select the Telnet command from the Agent menu.

5.4.2 WEB Browser

Starts the web browser specified in the External Command tab of the Options dialog box
(Option > Option > External Command). This menu item simply starts the web browser
with no argument (URL) specified.
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Note - To connect directly to the target device via HTTP, click the RS-232 port in the Panel
window and then select WEB Browser, or select the WEB Browser command from the
Agent menu.

5.4.3 MIB Browser

Starts the MIB browser (AMIGO) application that comes with Device Manager. Refer to the
AMIGO User's Guide for more details.

5.4.4 VLAN Manager

Starts the VLAN Manager application that comes with Device Manager. Refer to the VLAN
Manager User's Guide for more details.

5.4.5 QoS Manager

Starts the QoS Manager application that comes with Device Manager. Refer to the QoS
Manager User's Guide for more details.

5 Common Menus
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5.5 User Menu

In the User Menu, you can create, edit and execute user-defined menu items.

This function may be useful if there are a small number of Device Manager windows that
you use more often than all others (common GUI windows). Usually, you need to perform
several steps to open a window. By creating your own menu item, you can open the
windows by a single action. You can also add frequently used commands or applications to
the User Menu.

Topics:
e Create Your Own Menu Item
o Edit
¢ Common
o Target
_iof x|
File ‘iew Option #Agent PRouting Bridge Port  Tool | User Menu  Help
COmmen b AT-8624TI2M
Target B
- .~ DUFLEX
3 115 108A5E-T/100BASLTY , | FULLDUP =HALFDUP
) ol 5ol ol -l ool ol ol ool ol ol ol Gl |
o ] (NN o ol ol oy ol | |clgN oI ol ol ol o [ e | .
= l&mﬂb,.-j s
Q Fuk

Sysiem Marme: System Descrigtion:

AT-GE24 T2 llied Telesis AT-86Z4T/ZN version 2.9, 1-04
Systam Location: Z26-Feh-2007

ATF Laby
System Coract

Alied Telesis

l Connect |

User Menu
5.5.1 Create Your Own Menu ltem

To create a user-defined menu item, select User > Edit, or open the Options tab of the
common GUI window. In the Options tab, click on the 'Regist menu' button. The Regist
Menu Item window will appear. This window will allow you to add the currently opened
common GUI window to the User Menu. After adding the common GUI window, you can
open it by selecting it from the User Menu.
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User-defined menu items can be classified as either 'Common' or 'Target-specific'. Menu
items in the 'Common' group are always available, regardless of the target host. Menu items
in the 'Target' group are only accessible when you connect to the same target host as the
one you were connected to when creating the menu item.

5.5.2 Edit

Add, delete and edit user-defined menu items.

-+ User Menu Registraton x|
Fegistered Menu Add
= Common Menu
- lied! Te Retnove |
= Target Menu
FR. S':."S‘tEml:DJ Eljl't
Test
~Description:
Reqist place:  Common
Kircd: External command
Contents: C:VProgram Files‘\Internet Explorer’ IEXPLORE.EXE ;I
http: /fvmr, alliedtelesis. con T

Cloze

User Menu Registration

Add
Adds a new menu item to the selected group (Common Menu or Target Menu).

Remove
Deletes a selected menu item.

Edit
Changes a selected menu item.

User-defined menu items can be created to perform one of the following actions.

MIB display
Displays MIB variables of your choice in the common GUI window.
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Note - It takes times to get values for many variables. To improve performance, you
can limit the number of variables to be displayed to about 10. You can further
improve performance by increasing the polling interval when the volume of the data
is high.

HHEdit Menu Item x|

Menuttern Marne: Isys*tem(tlj

MIE v ariakle:

systen. O

Browse... |

Automatically generate menu hame from MIE varishle |

[0].4 | Cancel I

MIB display

MIB set
Sets a value for the MIB variable. Specify a variable and a value to set. You must
specify the variable with an instance number. For example, 'sysDescr.0' or
rptrMonitorPortEntry.|.8' are valid examples. If you specify a variable without an
instance such as 'sysDescr', the set operation cannot be performed.

Note - The MIB set operation changes the data structure in the device's SNMP agent.
Take care when using this function.
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Edit Menu Ikem x|
Menuttetn Marne: Isystem(tlj
MIE display External comimand I
MIE “ariakle: I Brovvse... |
MIE “alue: I LI
Avutommatically generate menu natne from MIE varishle |
(0] 14 Cancel
MIB set
External command
Executes the specified command line.
Edit Menu Item x|

henuftem Mame: I.&Ilied Telesiz anline

MIE displayl MIE ==t External command |

Cotmmand Marme:
IC:'I.F‘ru:ugram Fileztnternet ExploreriEXPLORE EXE

Brovwze... |

Arguiment:

Fittpo: Sy alliectelesis com

[0].4 | Cancel I

External command

5.5.3 Common

The Common submenu contains the user-defined menu items which are accessible

regardless of the target device.
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5.5.4 Target
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The Target submenu contains the user-defined menu items which are accessible only when
connected to the specific target device.

5 Common Menus
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5.6 Help

From the Help menu, you can view the online user's manual, license information and
version information for Device Manager.

Note - To view the online user's manual, you must first specify the web browser with which
to view it in the External Command tab of the Options dialog box.

Topics:

e Index

e ATl on-line
o License Registration

e About
_|of x|
AT AliCO Telzsls ATI orline ——————— AT-8624T/2M

License Registration

- 6115 teepse-Tiien  About E— ["Foucoue oo
MEEEETELE ﬂr-o-o.o-o-n- g

o j% ol ol ol ol ol ol ol ol ol of

System Marne; System Descrigtion:

AT-GE24T02N llied Telesiz AT-8G524T/ 2N version 2.9.1-04
Sy'stem Location: 6=Feh=-2007

ATP Lab
System Cortact

Adied Telesis

it .Pﬂfil

R

| Conrect |

Help menu

5.6.1 Index

Displays the main page of the online user's manual.
5.6.2 ATl on-line

Opens the Allied Telesis home page with the configured web browser.
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5.6.3 License Registration

AVE Allied Telesis

Device Manager can be evaluated for a limited period without a license. If you want to use
Device Manager after that period, you must obtain a license. Contact your authorized Allied
Telesis distributor or reseller.

In the License Registration menu, you can view, add and remove license information stored
in Device Manager.

When you buy a license, you are supplied with a license sheet with your License Key
printed on it. Enter this to register your license.

To register your license, follow these steps.
I. Start Device Manager.

2. Select Help > License Registration.
3. Click the 'Add' button (green +).

- License Registration X

x| ]

License Key Description I

Close

Click 'Add' button

4. Enter the License Key written on your license sheet, then click OK.

H Input License X|

Licenze Key: |1 1223344 A ABBCCDD

034 I Cancel |

Input License Key

5. Device Manager displays the registered license information.
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5.6.4 About

Displays version and copyright information for Device Manager-.

5 Common Menus
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6 MIB Variable Window

When you select a menu item to view information from the SNMP agent, a MIB variable
window with tabs appears. In this window, you can view MIB variables in several different
styles, set a threshold on variables for monitoring, change the value of the variables and
change options.

The window has some common components regardless of the information displayed. This
section describes operations which are common for all such MIB variable windows.

The MIB variable windows have several tabs, each of which displays variables in different
styles, such as tables, plot charts, and bar charts. You can quickly change the view by clicking
a tab.

Additionally, the MIB variable windows have a tab which is used to change the values of the
MIB objects, and a tab to configure options.

Note - To change MIB variables, you must have configured the community string for the
SNMP 'Set' operation both in Device Manager and on the device.

Note - The type of variables displayed determines which kind of tabs are displayed and
which are not. For example, chart tabs are not displayed when you are only viewing string
variables.

Note - SNMPv3: There are times that the MIB Variable Window will only display one row
with the value column displayed as blank. This happens when the user does not refresh the
Panel Window after removing the read permission on the MIB Group.

Note - SNMPv3: Depending on the user's view access security settings, the values of some
MIB objects may not be displayed.

Topics:

e Table Tab

e Plot Chart Tab
e Bar Chart Tab
e Edit Tab

o Options Tab
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Interface Info([1-2]) EI

Table | pict chart | Bar chart | Extt | Options |

| 5l

\._

AVE Allied Telesis

Part Nurber [ 2
Part Description 100ME_Ethernet_Port_2 100ME_Ethernet_Port_2 *
Part Type B [
MATL 1500 1500
Speed 100000000 100000000
Physical Address 003054 66 5016 0030846632017
Administration Status L up
Opetation Status dovwen cowv
Lazt Change Time and Date 0 days 0000:00 030 0 day= 0:00:00 030
Received Bytes ] ]
Received Unicast Packets ] ]
Received Mon Unicast Packets ] ]
Received Dizcard Packets ] ]
Received Errar Packets 0 0
Received Unknown Protocal Packets jl 0 | _Iﬂ
4 3

MIB Variable Window

AlliedView™-EMS 3.11 Device Manager User’s Guide

6 MIB Variable Window

Page 68 of 130



6.1 Table Tab

\..

> Allied Telesis

In the Table tab, MIB variables are displayed in a table. This is the default tab opened by a
menu item. Values in the table are updated at each polling interval.

Note - The type of variables displayed determines which kind of tabs are displayed and
which are not. For example, chart tabs are not displayed when you are only viewing string

variables.

Note - SNMPv3: Depending on the READ VIEWV access settings of the User Account Name
used, there is a possibility that Device Manager may not be able to access some MIB values.
When this happens, the table will display a blank cell for those MIB values.

Topic:

e Transpose Button

Interface Infof[1-2]}) il

Table | piot chart | Bar chart | Edit | options |

| |

Part Mumber [ 2
[ Part Description 100ME_Ethernet_Port_2 100ME_Ethernet_Port_2 =
Port Type 5 =3
hATLI 1500 1300
Speed 100000000 100000000
Physical Address 00 30 84 66 5016 003084 663017
Adminiztration Status up 4]
Opetation Status dovwen cowv
Lazt Change Time and Date 0 days 00000 030 0 day= 0:00:00 030
Received Bytes ] ]
Received Unicast Packets 0 0
Received Mon Unicast Packets ] ]
Received Dizcard Packets ] ]
Received Error Packets ] ]
Received Unknown Protocal Packets ] ]

Table tab
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6.1.1 Transpose Button

il flips rows and columns.

6 MIB Variable Window
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In the Plot Chart tab, variables are displayed as a graph. To the right of the graph is a table
of the numeric variables which can be displayed in the graph. Variables selected in the table
are plotted on the graph.

The scale of the vertical axis is automatically adjusted according to the values of the
variables. The graph is updated at each polling interval.

Note - The polling interval can be changed in the Options tab.

When you resize the window, the graph is resized accordingly.

Topics:

Graph
MIB Variable Table

Select All Button
Clear Button
Reverse Button

H Interface Infof[16-18])

Table Piot Chiart | Bar chart | Edit | options |

| 2]l o
1 |Speedris) -
1200 V2 |Speedr1?)
3 |Speedrts
1000 [T 4 |Received Bytes(16)
W 5  |Received Bytesi17)
[T 6 |Received Bytesi13)
go0 [T 7  |Received Unicast Packets(18)
. v & Received Unicast Packet=(17) |-
500 *5 3 Received Unicast Packet=(18)
g [T 10  |Received Mon Unicast Packet=(16)
14 17 11  |Received Non Unicast Packets(17)
400 *23 [ 12  |Received Non Unicast Packets(18)
| [T 13 |Received Dizcard Packet=(16)
1 W 14  |Received Dizcard Packet=(17)
2007 [T 15 |Received Dizcard Packets(18)
[T 16 |Received Error Packet=(16)
DZ.Z:Z:Z:Z:Z:Z:Z:Z:Z:Z}— E 13 EECE?VEL‘% Errl:lr fac!{e‘?ﬂgz? _ILI
a | ,
Plot Chart tab
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The components of the Plot Chart tab are discussed below.
6.2.1 Graph

The left half of the window contains the graph showing the values of the selected variables.
The vertical (Y) axis shows the values and the horizontal (X) axis shows time. New values
are plotted when Device Manager gets them, at the predefined polling interval.

The scale of the X-axis is automatically adjusted according to the number of values plotted.
The X-axis can display a maximum of the latest 20 values. The rightmost point is the most
recent.

Each variable is plotted in a different color and shape. A list of the variables on the graph
and their shapes and colors is displayed between the graph and the variable table.

By placing the mouse cursor on the plotted dot on the graph, you can see the exact values
(coordinates) of the variable. For example, when you move the cursor onto the 10th point
on the X-axis which has a value of 100, the numbers "(10,100)" are displayed.

6.2.2 MIB Variable Table

The right half of the window is the table of variables suitable for graph display. Each entry
has a checkbox. Only checked variables are plotted on the graph.

Assume that you selected four variables to display. If one of the variables has very large
values, for instance 1000000, and the other variables have low values, for instance
approximately 100, the vertical axis is automatically scaled to accomodate the largest
variable. In this situation, you can see only the largest variable because the scale of the
vertical axis is too large for other three smaller variables. To see smaller variables, uncheck
the largest variable temporarily.

Note - SNMPv3: Depending on the READ VIEVV access settings of the User Account Name
used, there is a possibility that some MIB variables will not be displayed in this table.

6.2.3 Select All Button

T%: checks all variables. Clicking this button causes all variables to be plotted on the graph.
6.2.4 Clear Button

I unchecks all variables.

6.2.5 Reverse Button

e flips the states of all checkboxes, that is, unchecks all variables currently selected and
checks all variables currently not selected.
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Note - Displaying many variables at the same time imposes a load on system resources. If
you encounter delay or reduced system performance, reduce the number of variables
displayed, or increase the polling interval. To reduce the number of variables, uncheck some
variables in the MIB variable table. To increase the polling interval, click the Options tab and
change the Polling Interval.

6 MIB Variable Window
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6.3 Bar Chart Tab

The Bar Chart tab displays variables as a bar chart. To the right of the graph is a table of the
numeric variables which can be displayed in the chart. Only variables selected in the table
are displayed in the chart.

The scale of the vertical axis is automatically adjusted according to values of the variables
displayed. The chart is updated at the polling interval.

Note - The polling interval can be changed in the Options tab.
When you resize the window, the chart is resized accordingly.
Topics:

o Chart

o MIB Variable Table
o Select All Button

e Clear Button
e Reverse Button

- Interface Info{[16-18])

Table | Plot Chart Bar Chert | Ecit | options |
| 2]y

i Speed
v

e 2 Received Bytes
— [ =3 Received Unicast Packets
Vv 4 Received Mon Unicast Packets
4007 [T 5 |Received Discard Packets

& Received Error Packets

7 Received Unknown Protocol Packets
1 e  — v & Transmitted Bytes

.P':'rt Mumber 16 [ Tranzmitted Unicast Packets

ClPart Mumber 17 [T 10 [Transmitted Non Unicast Packets

o WFort Mumber 15 [T 11 |Transmitted Discard Packets
[T 12 |Transmitted Error Packets
260 [T 13 |Transmitted Buffer Length
1001
n] + . +
S KT R i

Cloze

Bar Chart tab
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The components of the Bar Chart tab are discussed below.
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6.3.1 Chart

In the left half of the window is the chart showing the values of the selected variables. The
vertical (Y) axis shows the values and the horizontal (X) axis shows the variable name or
number. You can select whether to display the name or the number in Option > Option >
Other.

Each variable is shown with a different color. The colors of the variables are displayed
between the chart and the variable table.

By placing the cursor on a bar, you can see the exact value of the variable.
6.3.2 MIB Variable Table

The right half of the window is the table of variables suitable for graph display. Each entry
has a checkbox. Only checked variables are shown on the chart.

Assume that you selected four variables to display. If one of the variables has a very large
value, for instance 1000000, and the other variables have much lower values, for instance
around 100, the vertical axis is automatically scaled to accommodate the largest variable. In
this situation, you can see the largest variable only because the scale of the vertical axis is
very large. To see the smaller variables, uncheck the largest variable temporarily.

Note - SNMPv3: Depending on the READ VIEWV access settings of the User Account Name
used, there is a possibility that some MIB variables will not be displayed in this table.

6.3.3 Select All Button

% checks all variables. Clicking this button causes all variables to be plotted on the chart.
6.3.4 Clear Button

I unchecks all variables.

6.3.5 Reverse Button

g flips the states of all checkboxes, that is, unchecks all variables currently selected and
checks all variables currently not selected.
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Note - Displaying many variables at the same time imposes a load on system resources. If
you encounter delay or reduced system performance, reduce the number of variables
displayed, or increase the polling interval. To reduce the number of variables, uncheck some
variables in the MIB variable table. To increase the polling interval, click the Options tab and
change the Polling Interval.

6 MIB Variable Window
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In the Edit tab, you can change the value of any variable with read-write access. All variables
are displayed in a table. For variables which can be changed, a checkbox is displayed in the

first column. To change a value, input or select a new value in the MIB Value column, check
the variable, then click the Set MIB Value button.

Topics:

Checkbox Column
MIB Variable Column
MIB Value Column
Select All Button
Clear Button

Reverse Button

Get MIB Value Button
Set MIB Value Button
Threshold Button

Interface Info([16-18])

Table | Plt Chart | Bar Chart Edt | options |

| 2] ] o] e ] 13

MIE “ariable MIE *alue
Speedi16) 100000000
Speedi17) 100000000
Speedi18) 100000000
Physical Address16) 00 3054 6650 25
Physical Address(17) 00 3054 66 50 26
Physical Addres=15) 00 3054 66 50 27

[T | Administration Status16) up

[T | Administration Status17) up

[T | Administration Status(18) up
Operation Status(16) daowyn
Operation Status(17) up
Operation Status(13) dovwen

Last Change Time and Date(16)

0 days 00000 040

Last Change Time and Date(17)
4

0 days 00045 720

s

Close

Edit tab

In the Edit tab, variables are shown in a table. The table has the following columns (fields)
for each entry.
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6.4.1 Checkbox Column

The first (leftmost) column shows whether or not the variable can be changed (i.e. the
variable supports the SNMP Set operation). If a checkbox is displayed in the column, the
variable's value can be changed.

When you change several variables, set the new values in the Value column and then check
all corresponding boxes. Device Manager sends new values for selected variables in a batch.

6.4.2 MIB Variable Column
MIB variable names are displayed.

6.4.3 MIB Value Column

The value of the variable is displayed. If the variable has write access (and a checkbox is
displayed in the first column), this field is editable. To change the MIB value, change the
value and check the box and then click the Set MIB Value button. If the variable takes a
value from a fixed set of options, this field works as a pull down listbox. For such a variable,
clicking this field shows the listbox.

The value in this field is the one at the time when this tab is opened. The value in this
column is not updated automatically. If you want to see the latest value, use the Get MIB
Value button or switch to the Table tab.

Note - SNMPv3: Depending on the READ VIEWV access settings of the User Account Name
used, there is a possibility that Device Manager may not be able to access some MIB values.
When this happens, the table will display a blank cell for those MIB values.

6.4.4 Select All Button

T%: checks all variables that can be changed.

6.4.5 Clear Button

T unchecks all variables that can be changed.

6.4.6 Reverse Button

o Flips the states of all checkboxes, that is, unchecks all variables currently checked, and
checks all variables currently not checked.

6.4.7 Get MIB Value Button

el Updates the MIB Value fields of the selected variables. To select a variable, click the MIB
Variable field of the target variable.
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6.4.8 Set MIB Value Button
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et Changes the values of the checked variables, using the SNMP Set operation. The values
in the MIB Value fields are sent to the SNMP agent on the device.

Note - SNMPv3: Depending on the WRITE VIEWV access settings of the User Account Name
used, there is a possibility that Device Manager may not be able to set some MIB values.
When this happens, a "No access error." value will be displayed on the affected MIB Value
cells.

Note - SNMPv3: If the User Account Name does not have READ VIEW but has WRITE
VIEW access for a MIB variable, you may still set the value of that variable. However, the
new value will not be displayed on the affected MIB Variable cells.

Note - SNMPv3: Device Manager still allows the user to set values for the following
parameters even if the user has No Write access to these:

o System Name
e System Contact
e System Location

The write attempt will eventually fail and the value, "No access error"” will be displayed on
the value column for the said parameters. Additionally, the new values set will be displayed
on the Panel Window, but once the user refreshes the display, the values on the Panel
Window will be reset to the original values set on the device.

6.4.9 Threshold Button

E£:: Set a threshold on the selected variable. The threshold is used to monitor the variable's
value. If the threshold is exceeded, the action configured on the Options menu is executed.
To select a variable, click the MIB Variable field of the target variable. When you click the
Threshold button, the Edit Threshold Item dialog box appears.

H Edit Threshold Item X|
MIE S arizkble: IifOutLIu:asthtsj Brovwse. .. |
Walue: I1 2345

(034 | Cancel I

Edit Threshold Item dialog box

The MIB Variable field shows the selected variable name.
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To set a threshold, enter a threshold value in the Value field, then click OK. Note that this
specifies a rising threshold which triggers an event when the variable's value increases to
exceed the threshold, i.e. crosses the threshold from below.

When the threshold is reached, a pop-up message is displayed or a predefined command is
executed. You can select which action is executed in the Option > Option > User Action
tab.

Note - Thresholds can only be used for variables of type GAUGE, INTEGER, COUNTER,
GAUGE32, INTEGER32, COUNTER32, or COUNTERé64.

6 MIB Variable Window
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6.5 Options Tab

In the Options tab, preferences specific to the MIB variable windows can be changed.

Topics:

e Polling Interval
e Display Data Type of Chart

e Regist Menu
e Save Polling Data

o Start Snapshot
e Default Button

H{FDB Table Parameters x|
Table | Egt  Options |

|8

~Paliing Interval:

Palling Interval: |20 j @ zec O min

~Dizplay data type of chart:
" Apzolge % Relstive

Regist menu |

Save polling data |

Start shapshot |

Options tab
6.5.1 Polling Interval

Specifies the polling interval. The valid range is 5 seconds to 3600 seconds (| hour).
However, a short polling interval may reduce system performance. Care must be taken to
set an appropriate value for your system.

6.5.2 Display Data Type of Chart

Specifies how to display data on graphs or charts. Select one of the following two options.
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Absolute
Displays a value as it is.

Relative
Displays a change in the value per second. This is (Current value - Previous value) /
Polling Interval.

Note - The change here takes effect the next time the data is polled.
6.5.3 Regist Menu

Add this window to the User Menu. If you want to view the current window repeatedly, do
the following.

I. Click "Regist menu".

2. On "Regist Menu Item" dialog box, select one of "Common Menu" or "Target
Menu". Common Menu is always accessible regardless of the target device. Target
Menu can be accessed only when connected to the same specific device type.

3. Optionally, change the Menultem Name. This string is displayed as the menu item
name.

4. Click OK.
6.5.4 Save Polling Data

Save the collected data to a file. When you click this button, the Polling Data Save dialog
box appears and lets you specify the name of the file and the file format. To start saving data,
click OK in the Save Polling Data dialog box. The Save polling data button changes to

"Saving polled data". To close the file and stop saving data, click this button again.

The file format can be selected from the following options:

CSV Format
Save data in comma-separated values (CSV) format.

TAB Format
Save data in Tab-separated values (TSV) format.
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Save Polling Data x|
File natme: I&Ilied Telesis\blliediew -EMS"tnpilogfie cow Erowvsze. .. |
File type:  |CSY Format -]

TAE Format
O | | Cancel I

Save polling data
6.5.5 Start Snapshot

Clicking this button opens the Start Snapshot window. Use this window to save the
information displayed in the front panel, as well as tables or charts representing device
information. Use the 'Browse' button to select the directory or folder where you want to
save the image.

Note - You can generate an image of the main panel, table data, or charts. The type of image
or device information that you can generate depends on which menu you opened the Start
Snapshot window from. For more information on the file types created in the Start
Snapshot window, see section 5.2.6.

H start Snapshot |
File natme: Is'l.&llied Telesiz\AlliedView-EMStmplienapshot bt Erowvsze. .. |
Select:

IV Main panel

¥ Takle data ™ |Pict chart
[~ Bar chart [~ Pie chart

v Reload
Foreground Colar, ————————————— EBackground Colar:

. Color zelection | Color zelection
[0].4 | Cancel I

Start snapshot

Below is a snapshot from the MIB Variable window, with the main panel and table data both
marked in the Start Snapshot window:
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Fle Edt ‘iew Faworites Tools Help
eBackrev B @ @"Oﬁeam %‘*}\?Faﬁuites @'ﬁv& 'D%*ﬂ
ddress | C:\Program Files)alied Telesis|alliedview-EMSjtmplsnapshot. htm =] B eo |unks >

X! - 2

jl Search Web I-l@v | {ﬁ!]'ﬂ'adqna'ks . atkempting bo retrieve buttans from Yahoal ..

Interface Info(ifEntrv.[3-5])

192.168.10.56 - Device Manager for AT-8224X1,

200505012 144744

F

Front Panel

Table

Port IMumber

flndes) 3 4 5

E_;;E?;;mpm 100MB_Fthernet Port 3 |100MB_Ethemet Port 4 |I00MB_Ethernet Port 5

Dort Type(@Type)  Eemet CSMACD  Ethernet CSMA/CD | Ethernet CSMA/CD

TPEEIIP {ethernet-csmacd) (ethemet-csmacd) (ethernet-csmacd)

MTU (M) 11500 11500 11500

Speed(ifSpeed) 100000000 1100000000 1100000000

R [ [ _Ij
_‘? | »
/& Dore LT TS My Computer 4
MIB Variables snapshot

6.5.6 Default Button

. Reset all options to default settings.

6 MIB Variable Window
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The RMON (Remote network MONitoring) facility collects management information from
remote monitoring agents. Monitoring agents are implemented as dedicated hardware
devices or are built into networking devices like switches.

With Device Manager, you can view management information retrieved from built-in
RMON agents on the Allied Telesis switches that support RMON. You can also configure
RMON agents to selectively collect information or set thresholds on variables to monitor
their value.

Note - The RMON menu is displayed only if the target device supports the RMON MIB.

Note - Device Manager supports the following RMON groups only: Statistics, History, Alarm
and Event.

Topics:
o RMON-specific Buttons
e Statistics
o History Control Table
e Alarm Table
e Event Table
o Eventlog

7 RMON
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7.1 RMON-specific Buttons

The RMON window is slightly different from the MIB variable windows. The RMON
window has several tabs and each tab has the following tool buttons in addition to the
buttons in the MIB variable windows.

Absolute Value &5
Displays collected data as they are.

Per Sample n
Displays the difference between the last two sampled values. The value is rounded.

Per Second R
Displays the difference between the last two sampled values per second. This is
(Current value - Previous value) / Polling Interval. The value is rounded.

Start Polling &
Restarts polling.

Stop Polling &
Pauses polling. This may be useful for examining current data carefully.

Refresh £
Forces immediate polling and displays the latest sampled value regardless of the
regular polling timer.

7 RMON
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7.2 Statistics

From the Statistics menu, you can view RMON Statistics information.
Topics:

e Data Group Buttons
¢ Management Information Area

e Entry Tab
e Table Tab

e Plot Chart Tab
e Pie Chart Tab

o Options Tab
e Close

Statistics(17) x|
Ltilization | I Packet Size Packet Type | Errar Type | Custom |
Ertry Table | piot chert | pie Chart | ogtions |
Absolute Walue Per Satmple Per Second
Size Under 64 Packets 0 ] u]
Size 64 Packets 1619 285 14
Size B5 - 127 Packets 1274 29 1
Size 128 - 255 Packets 32 0
Size 256 - 511 Packets 45 0
Size 512 - 1023 Packets a4 12 1
Size 1024 - 1518 Packetz u}
Size Owver 15158 Packets 0 ]
Port17: 100 mbps Palling Intersal; 20 sec I Palling Per Satnple
Ihdex: 17 Data Source: iflndex. 17 Cyvrier: anitar Status: valid

RMON Statistics window
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7.2.1 Data Group Buttons

In the RMON Statistics window, you can view various network statistics. Data is grouped
by the type of information. You can view each type of information by clicking a Data Group

button at the top of the window (just below the title bar).

Note - Data Group buttons change the data to be displayed. The tabs change the view of the

data, that is, how the data selected by the Data Group buttons is displayed.
The following Data Group buttons are available.

Utilization

Shows utilization as a percentage. This is calculated by Device Manager.

Packet Size
Shows the number of packets by their octet size.
o Size Under 64 Packets (calculated by Device Manager)
o Size 64 Packets
o Size 65-127 Packets
o Size 128-255 Packets
o Size 256-511 Packets
o Size 512-1023 Packets
o Size 1024-1518 Packets
o Size Over 1518 Packets (calculated by Device Manager)

Packet Type
Shows the number of packets for each of the following categories.
o Received Packets
o Unicast Packets (calculated by the Device Manager)
e Broadcast Packets
o Multicast Packets

Error Type
Shows the number of packets categorized by error types.
o Good Packets (calculated by Device Manager)
e Error Packets (calculated by Device Manager)
o Collision Packets
e CRC Alignment Error Packets
e Undersize Packets
o Oversize Packets
e Fragment Packets
e Jabber Packets

Custom
Shows all items plus Received Bytes but without Utilization.
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Note - Items calculated by Device Manager always have the descriptive title (not the
variable name) because they have no related MIB variables.

7.2.2 Management Information Area

At the bottom of RMON Statistics window, the following information is always displayed.

PortX: yyy Mbps
X is the port number of the selected port. yyy is the speed of the port.

Polling Interval: yyy sec
yyy is the polling interval in seconds.

In Polling / Polling Stopped
Status of polling. "In Polling" or "Polling Stopped".

Absolute Value / Per Sample / Per Second
Indicates how data is displayed.

Index
Value of etherStatsindex of the RMON Statistics group.

Data Source
Value of etherStatsDataSource of the RMON Statistics group.

Owner
Value of etherStatsOwner of the RMON Statistics group.

Status
Value of etherStatsStatus of the RMON Statistics group.

7.2.3 Entry Tab

In the Entry tab, you can select and control the table entry displayed. Data collected by the
selected entry is shown in the Table, Plot Chart and Pie Chart tabs. By default, the entry
with the lowest index number is selected. In this tab, you can also add, remove or edit the
entries.

Topics:

e Available Control Table Entries
e Select Button

e Add Button

e Edit Button

e Remove Button
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Statistics{17) x|
Litilization | I Packet Size Packet Type | Errar Type | Custom |
Eriry | Tale | Pt chart | Pie Ghart | options |
| & || |4y
Available Contraol Takle Entries
Incle:x I Data Source Status Oyt

1 fiflrdex.1 valicd monitar &
2liflndex.2 valicd monitar
Sliflndex.3 valicd monitar
4 liflndex.4 valicd monitar
aliflncex.s walicl manitar
Bliflncex 6 walicl manitar
7 liflncex. 7 walicl manitar
Gliflncex.5 walicl manitar
9liflndex.9 walicl manitar oz

10iflndex.10 walicl rnanitar

11 |iflndex .11 walicl rnanitar

12|iflndex 12 valicl rnonitar

13iflndex.13 valicl rnonitar

14 |iflndex .14 valicl rnonitar

15 iflncex 15 walicd manitar |

Part1 7: 100 Mbps Palling Interval: 20 sec In Palling Per Sample
Inclex: 17 Data Source: iflndex.17 Oyt manitor Status: walid

Close

RMON Statistics Entry tab

7.2.3.1 Available Control Table Entries

This table shows all control table entries configured on the target RMON agent. Data
displayed in the RMON Statistics window is collected using the selected control table entry.
Here you can create a new entry, or change or delete an existing entry. By default, the
topmost entry is automatically selected.

The control table is not automatically updated. If you want to see the latest information,
click the Refresh button.

The table has the following columns.

Index

The index number used to identify this entry.

Data Source

The index of the RMON interface which collects statistics for the entry.
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The status of the control entry.

Owner
The owner (creator) of the control entry.

7.2.3.2 Select Button

-2 changes the control entry displayed in the Statistics window. To change an entry
displayed, select the entry in the table, then click the Select button. Data collected for the
selected entry is displayed on other tabs thereafter.

Note - When you edit the current entry, or when you add an entry with the same index

number after removing the current entry, make sure to select the entry again. Otherwise,
the changes will not take effect on the other tabs.

7.2.3.3 Add Button

= adds a new entry to the RMON Statistics control table. When you click this button, the
Add Control Table Entry dialog box appears. Enter the Index, the Data Source and the
Owner, then click OK to create an entry.

H Add Control Table Entry X|

Indles: |1 7

Data Source: Iiflndex.1

Chovrier: Inwner

Ok | Cancel I

Add Control Table Entry dialog box

7.2.3.4 Edit Button

[¥: changes the selected entry. To edit the entry, select an entry on the table then click the
Edit button. The Modify Control Table Entry dialog box appears. Change the required
parameters, then click OK. You can also open the dialog box by double-clicking the desired
entry.
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7.2.3.5 Remove Button
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#: removes the selected entry from the table. Be careful in using this button because the
entry is deleted without any confirmation.

7.2.4 Table Tab

In the RMON Statistics Table tab, network statistics are shown in the table format. The
data is updated at the polling interval.

Topics:

e Sort
e Reset Table Button

ﬂ
Ltilization | Packet Size | Packet Type | Errar Type |
Ertry Table | piot chert | pie Chart | ogtions |
| =R | O£
Absolute Walue Per Satmple Per Second
Received Bytes SES622 16493 149 1=
Received Packets E375 245 12
Unicast Packets 1134 9 1]
Eroadcast Packets 5244 237 12
Multicast Packets 1] 1] 0
zood Packets B3T 245 12
Etror Packets 7 0 0
Drop Everts 0 0 o
CRC Aligniment Errar Packets 0 0 o
Undersize Packets 0 0 0 |-
Cversize Packets 1] 1] 0
Fragmett Packets 7 0 0
Jabber Packets 1] 1] 0
Collizioh Packets 0 0 0
Size Under 64 Packets 7 0 1] L_I
Port17: 100 mbps Palling Intersal; 20 sec I Palling Per Satnple
Inclex: 17 Data Source: iflncex .17 Craenier: monitar Status: valicl

RMON Statistics Table tab
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7.2.4.1 Sort

To sort table items, click a column title. When you click the column title, table items are
sorted by the column in ascending order. One more click sorts the items in descending
order. To restore the original order, click the Reset Table button.

7.2.4.2 Reset Table Button

R Reorders table items after using sorting function.

7.2.5 Plot Chart Tab

In the Plot Chart tab, network statistics are shown in the time-scaled plotting graph. Data is
updated at the polling interval. The horizontal axis contains a maximum of the 40 latest

values.

Topics:

e Popup Display

HH Statistics(17) x|

Itilizaticr |

Ertry | Table Plot Chart | pie chart | Options |

| | oA | 2 21| | 2| @) 2|

Packet Type | Errar Type Custom

|_7 1 Size Under 64 Packets
=08 v 2 |Size 64 Packets
. % IV 3 |SizeB5- 127 Packets
400 ¥ 4 |size 128 - 255 Packets
W 5  |Size 256 - 511 Packets
@1 |V 6 |Sizes12-1023 Packets
300 2 |7 |Size 1024 - 1518 Packets
T &3 [V &  |SizeOver 1515 Packets
4
200 i
1 | :
100 & . —7
1 w L‘ﬁ[‘\/ \.J \-\ 8
K1 i

Part1 7: 100 Mbps Palling Interval: 20 sec In Palling Per Satmple

Index: 17 Data Source: iflndex. 17 e, monitor Status: valid

Close

RMON Statistics Plot Chart tab
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You can see the exact value of a plotted dot by moving the mouse cursor onto the dot. The
values are displayed in the form "(x, y)". where x indicates the time elapsed after the RMON
window is opened and y indicates the value of the data.

Below the graph's horizontal axis, time is displayed. Note that the times shown there are
only for your reference. They are not synchronized with the polling interval plotted dots.

7.2.6 Pie Chart Tab

In the Pie Chart tab, network statistics are shown in a pie chart. This chart is useful for
checking the proportions of the various packet counts. The data is updated at the polling

interval.

Note - The pie chart is not displayed when all data has the value zero.

Topics:

e Popup Display

H statistics{17) x|
Litilization | Packet Tyvpe | Error Type Custom
Ertry | Table | Plot chert Pie Chart | optione |
[aalal
| | = 1) | @) 2
W 1 |Size Under 64 Packets
v 2 |Size 64 Packets
¥ 3 |Size 65 - 127 Packsts
v 4  |Size 128 - 255 Packets
W 5  |Size 256 - 511 Packets
Cl1 | & |Size 512 - 1023 Packets
BW: [V 7 |Size 1024 - 1518 Packets
Oz [ & |size Over 1518 Packets
[P
s
3
07
M=
Packet Size
1 |— i
Port17: 100 Mbps Palling Irterval: 20 sec v Pallitigy Per Sample
Index: 17 Data Source: iflndex 17 Owvniet: monitor Status: walid

RMON Statistics 3-D Pie Chart tab
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When you move the mouse cursor onto a section of the pie chart, the value of the data for

the selected area is displayed.

7.2.7 Options Tab

In the Options tab, you can customize the display options or edit the statistics data.

Topics:

e Polling Interval
e Display Data Type of Chart

o Regist Menu
e Save Polling Data

e Start Snapshot

H statistics{17)

Liilization |
Ertry | Table | Plot Chert | Pie Chart  Options |

I8

Packet Type | Error Type Custom |

X

~Polling Interyal:

Palling Interyal: |20 ﬂ % zec  { min

~Display data type of chart:
" Apzolte Value (% Per Sample " Per Second

Redist menu

Save polling data

Start shapshot

Porti 7: 100 Mbps  |Polling Interval: 20 =... In Palling Per Sample

Inclex: 17 Data Source: iflnde. .. Crvrier: maonitor Status: walid

Close

RMON Options tab (Statistics)
7.2.7.1 Polling Interval

You can change the polling interval here.
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Specifies how to display data on the graph or chart. You can select one from the following
options.

Absolute Value
Displays a value as it is.

Per Sample
Displays the change in the value between the two pollings. This is Current value -
Previous value.

Per Second
Displays the change in the value per second. This is (Current value - Previous value)
/ Polling Interval.

Note - Calculated values are rounded. For example, Number of Error packets is usually very
small so that calculated value is likely to be zero.

7.2.7.3 Regist Menu

Add this window to the user-defined menu (User Menu).

7.2.7.4 Save Polling Data

This button opens the Polling Data Save dialog box used to save collected data to a file.
Specify the name and format of the file in which the data is saved. Select a file format from
the options below. To start saving the data, click OK.

When you start saving data, the button's label changes to "Saving polled data". To close the
file and stop saving the data, click the "Saving polled data" button.

CSV Format
Save the data in comma-separated values (CSV) format.

TAB Format
Save the data in Tab-separated values (TSV) format.

Note - Only the values of the collected RMON variables are saved. Values Device Manager
calculates from these collected values are not saved.

7.2.7.5 Start Snapshot

Clicking this button opens the Start Snapshot window. Use this window to create an image
of the graph and tables in the RMON tab panel in HTML format. Use the 'Browse' button
to select the directory or folder where you want to save the image.
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Note - You can generate an image of the main panel, table data, or charts. The type of image
or device information that you can generate depends on which menu you opened the Start
Snapshot window from. For more information on the file types created in the Start
Snapshot window, see section 5.2.6.

X
File natme: Is'l.&llied Telesiz\AlliedView-EMStmplienapshot bt Erowvsze. .. |
Select:

IV Main panel

¥ Takle data ¥ Plot chart
[~ Bar chart V¥ Pie chart

v Reload
Foreground Colar, ————————————— EBackground Colar:

. Color zelection | Color zelection
[0].4 | Cancel I

Start snapshot
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Below is a snapshot from the RMON Statistics window, with the main panel and table data
marked in the Start Snapshot window:

3 192.168.10.56 - Device Manager for AT-8224XL: Statistics(etherStatsEntry.1) - Microsoft Internet Explorer =10 x|
Fle Edt View Favorites Toos Help | &
@Backr@v@ @%|pm E%Fmixs @|B"‘E}l 'D%*ﬂ
Adiress |  C:ipragram Files\alied TelesiialisdvienEMSitmptsnapshot.Him ] oo s >
57 - 2| || search web |r|ﬁv| (11 Bockmarks ...sttemping to retrieve buttans from Yahoal ..
192.168.10.56 - Device Manager for AT-8224XL =
Statistics(etherStatsEnirv. 1)

20050512 14:54:52

Front Panel

Table
)ﬁbsolute ‘Pa:r Per
alue Sample  |Second
Received Bytes(etherStatsOctets) 0 0 0
Received Packets{etherStatsPkis) 0 0 0
Unicast Packets 0 0 0
Broadcast Packets(etherStatsBroadcastPlts) 0 0 0
Muliicast Packets(etherStatsMulticastPkts) 0 0 0
Good Packets 0 0 0 .
4 ol
/€] Done C LT T [ my Computer /

RMON Statistics snapshot
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7.2.8 Close

Closes the RMON Statistics window.

7 RMON
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7.3 History Control Table

From the History Control Table menu, you can view RMON History information.

Note - If there is a large amount of history data, it takes Device Manager a long time to
retrieve this data when you open the History Control Table window. If the message "Please
wait for a while" is displayed for a long time, decrease the "Request Bucket" value in the
Entry tab of the History Control Table window.

Topics:

e Data Group Buttons
e Management Information Area

e Entry Tab
e Table Tab

e Plot Chart Tab
e Pie Chart Tab

o Options Tab
e Close
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- History Control Table{17)

Litilization | Packet Type | Etrar Type ” Custam

Ertry Table | piat chert | pie Ghart | options |

| Bl o 1] S| 2| @]

Received Bytes

Max Value | Min Value | Average ... | 903

AVE Allied Telesis

Good Packets

Received Packets

Unicast Packets

Eroadcast Packets

Error Packets

Fragiment Packets

Multicast Packet=

Drop Events

CRC Alignment Error Packet s,

Undersize Packets

Owversize Packets

Jabber Packets

Collizion Packet=

57050 14900
551 126
551 127
5 21
ITh 106
L 0

L 0

0 0

0 0

0 0

0 0

0 0

0 0

0 0

Port17: 100 Mbps

Palling Intersal 20 zec

Inclex: 17

Data Source: iflndex.17

X
a0z 301
30285 21364 43085 17838
k3 ] 225 445 171
Ey 1] 228 445 172
89 21 286 22
230 207 159 150
1 1] a 1
1 1] a 1
0 1] a 1]
0 0 o 0
0 0 o 0
0 0 o 0
0 1] a 1]
0 1] a 1]
0 1] a 1]
1 I
I Pallifg Per Satnple
Crner: monitor Status: valid

Cloze

RMON History Control Table window

7.3.1 Data Group Buttons

At the RMON History Control Table window, you can view the history of various network
statistics. Data is grouped by the type of information. You can view each type of information
by clicking a Data Group button at the top of the window (just below the title bar).

Note - Data Group buttons change the data to be displayed. The tabs change the view of the
data, that is, how Device Manager displays the data selected by the Data Group buttons.

The following buttons are available.

Utilization

Shows utilization as a percentage, calculated by Device Manager.
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Packet Type
Shows the number of packets by the following types.
e Received Packets
e Unicast Packets (calculated by Device Manager)
e Broadcast Packets
e Multicast Packets

Error Type
Shows the number of packets categorized by error types.
e Good Packets (calculated by Device Manager)
e Error Packets (calculated by Device Manager)
e Collision Packets
e CRC Alignment Error Packets
e Undersize Packets
e Opversize Packets
e Fragment Packets
e Jabber Packets

Custom
Shows all items plus Received Bytes but without Utilization.

Note - Items calculated by Device Manager always have the descriptive title (not a
variable name) because they have no related MIB variables.

7.3.2 Management Information Area

At the bottom of the RMON History window, the following information is always displayed.

PortX: yyy Mbps
X is the port number of the selected port. yyy is the speed of the port.

Polling Interval: yyy sec
yyy is the polling interval in seconds.

In Polling / Polling Stopped
Status of the polling. "In Polling" or "Polling Stopped".

Absolute Value / Per Sample / Per Second
Indicates how the data is displayed.

Index
Value of etherStatsindex of the RMON Statistics group.

Data Source
Value of etherStatsDataSource of the RMON Statistics group.
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Owner

Value of etherStatsOwner of the RMON Statistics group.

Status

Value of etherStatsStatus of the RMON Statistics group.

7.3.3 Entry Tab

\..
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In the Entry tab, you can select a control table entry to view. Data collected by the selected
entry is shown on the Table, Plot Chart and Pie Chart tabs. By default, the entry with the
lowest index number is selected. On this tab, you can also add, remove or edit entries.

Topics:

e Available Control Table Entries

e Select Button

e Add Button
o Edit Button

¢ Remove Button

History Control Table{17) |
Litilization | Packet Type | Etror Type | I Custom
Entry | Table | Piot chart | Pie chart | Options |
| ©| || |4
Available Control Takle Entries
Inclex I Data Source I Request Buckets | Granted Buckets | Sampling Interval | Status Owher I
Eliflnclex & 25 25 30 vealicl rnonitar ;I
T |iflncles. 7 25 25 30 vealicl rnonitar
Gliflnclex 5 25 25 30 vealicl rnonitar
9liflnclex.9 25 25 30 valicl rnonitar
10iflndex 10 25 25 30 valicl rmonitor
11 |iflndex 11 25 25 30 valicl rmonitor
12iflnclex 12 25 25 30 wvalid monitor
13iflnclex 13 25 25 30 wvalid monitor
14|iflnclex 14 25 25 30 wvalid monitor
15]iflncdex 15 25 25 30 wvalid monitor
16|iflncdlex 16 25 25 30 wvalid monitor
17 iflnclex 17 25 25 30 wvalid monitor -
15|iflnclex 18 25 25 30 wvalid monitor
19]iflnclex .19 25 25 30 wvalid monitor
20/iflnclex 20 25 25 30 wvalid monitor LI
Part17: 100 Mbps Palling Interval: 20 sec In Polling Per Sample
Inclex: 17 Data Source: iflndex.17 Cwvner: monitor Status: walid
RMON History Entry tab
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This table shows all control table entries configured on the target RMON agent. Data
displayed in the RMON History window is collected using the selected control table entry.
Here you can create a new entry, or modify or remove an existing entry. By default, the
topmost entry is automatically selected.

The Control table is not automatically updated. To see the latest information, click the
Refresh button.

The table has the following columns:

Index
The index number used to identify this entry.

Data Source
The index of the RMON interface which collects history samples for the entry.

Request Buckets
The number of values which you asked the RMON agent to store.

Granted Buckets
The number of values the RMON agent allows you to store.

Sampling Interval
The time interval at which the RMON agent collects data.

Status
The status of the control entry.

Owner
The owner (creator) of the control entry.

7.3.3.2 Select Button

-2 changes the control entry displayed in the History window. To change the control entry
displayed, select an entry in the table, then click the Select button. Data collected by the
selected entry is displayed on other tabs thereafter.

Note - To display changes to the current entry, or to display a new entry with the same

index number as a previously removed entry, be sure to select the current entry.
Otherwise, the changes will not take effect on the other tabs.
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=F: adds a new entry to the RMON History control table. When you click this button, the
Add Control Table Entry dialog box appears. Enter the following parameters, then click OK
to create an entry.

Index
The index number used to identify this entry.

Data Source
The index of the interface on which the RMON agent collects data.

Request Buckets
The number of values which you want the RMON agent to store.

Sampling Interval
The interval at which the RMON agent retrieves data.

Owner

The creator (owner) of this entry.

Add Control Table Entry il

Inclesx: |2T-'

Data Source: Iiflndex.1

Request Buckets: |4III

Sampling Intersal: |3III

et Iawner

[0].4 | Cancel I

Add Control Table Entry dialog box

7.3.3.4 Edit Button

[¥: changes the selected entry. To edit the entry, select an entry on the table then click the
Edit button. The Modify Control Table Entry dialog box appears. Change the settings, then
click OK. You can also open this dialog box by double-clicking the desired entry.
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#: removes the selected entry on the table. Be careful in using this button because the
entry is deleted without any confirmation.

7.3.4 Table Tab

In the RMON History Table tab, RMON history information is displayed in table format.
The data is updated at the polling interval.

Topics:

e History Table
e Sort

e Reset Table Button

History Control Table{17) |
Litilization | Packet Type | Etrar Type |
Ertry Table | piat chart | pie Ghart | options |
0:00

| B R [ 11| 2| @)

Max Value | Min Value | Average.. 513 915 917
Received Bytes 57050 14900 2736 24363 26952 19777
Good Packets 551 126 300 316 354 239
Received Packets 551 127 301 T 354 239
Unicast Packets 35 16 62 17 16 24
Eroadcast Packets 1) 106 239 300 336 215
Etror Packets 5 0 1 1 0 1]
Fragmett Packets 5 0 1 1 0 1]
Mutticast Packets 0 0 0 0 0 1]
Drop Events 0 0 0 0 0 1]
CRC Alignment Error Packets,. 0 0 1] 0 u] 0
Underzize Packets 1] 0 0 0 u] 0
Cwversize Packets 1] 0 0 0 u] 0
Jabber Packets 0 0 0 0 0 1]
Collizion Packets 0 0 0 0 0 1]

1N 2
Part17: 100 Mbps Palling Interval: 20 sec I Palling Per Sample
Inclex: 17 Data Source: iflndex.17 Cwvner: monitor Status: walid
RMON History Table tab
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The table shows history data for the selected control table entry. The table has the
following columns:

Max Value
Shows the highest value of each variable after the current history control entry is
selected at the Entry tab.

Min Value
Shows the lowest value of each variable after the current history control entry is
selected at the Entry tab.

Average Value
Shows the average value of each variable after the current history control entry is

selected at the Entry tab.

XXXXXX
Sample Index. A maximum of the 40 latest index numbers are displayed.

7.3.4.2 Sort

To sort table items, click a column title. When you click the column title, table items are
sorted by the column in ascending order. One more click sorts the items in descending
order. To restore the original order, click the Reset Table button.

7.3.4.3 Reset Table Button

M Reorders table items to their original order after sorting.

7.3.5 Plot Chart Tab

In the RMON History Plot Chart tab, RMON history information is displayed in a time-
scaled plotted graph. Data is updated at the polling interval. The horizontal axis holds a
maximum of the 40 latest data values.

Topics:

e Popup Display
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Ertry | Table Piot Chart | pie Chart | options |

[ | oA || 2 21| | 2| G| 2|

\_

|

v 1 |Ltilization
0
X
0
L
[
| | | | | | | | |
o o o @D o = 4 4 4
= [ o] = [=p] oo = ka2 o o
o o o o o o o o o
[mm] [mm] (o} [mm] (o} [mm] [mm] (o} [mm]
Kl 2+
Port17: 100 Mbps Palling Intersal 20 zec I Pallifg Per Satnple
Inclex: 17 Data Source: iflndex.17 Cwvner: monitor Status: walid
RMON History Plot Chart tab

7.3.5.1 Popup Display

You can see the exact value of a dot by moving the mouse cursor onto the dot. The values
are displayed in the form of "(x, y)". where x indicates the elapsed time (sysUpTime seconds)
and y indicates the value of the data.

Below the graph's horizontal axis, time is displayed. Note that the times shown there are
only a reference point. They are not synchronized with the plotted dots.

7.3.6 Pie Chart Tab

In the Pie Chart tab, network statistics are shown in the pie chart. This chart is useful for
checking the proportions of the various packet counts. The data is updated after each

polling interval.

Note - The pie chart is not displayed when all values are zero.

AlliedView™-EMS 3.1 | Device Manager User’s Guide

Page 108 of 130



—

Topics:

AVE Allied Telesis

e Popup Display

History Control Table(17) 5[
Litilization | i Etrar Type | Custam |
Ertry | Table | Plat chart  Pie Chart | options |
Q:00
| | || 11| 8] )| @) Y
v 1 Received Packets
v 2 |Uricast Packets
v 3 EBroadcast Packets
v 4 |Muticast Packets
Ch
H:
O3
M4
Packet Type
Kl | 2|
Port17: 100 Mbps Palling Intersal 20 zec I Pallifg Per Satnple
Inclex: 17 Data Source: iflndex.17 Cwvner: monitor Status: walid
RMON History Pie Chart tab

7.3.6.1 Popup Display

To display the numeric value for a particular section of the pie chart, move the mouse
cursor onto that section.

7.3.7 Options Tab

In the Options tab, you can customize the options for viewing and editing the RMON
history data.
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Topics:

e Polling Interval
e Display Data Type of Chart

e Regist Menu
e Save Polling Data

e Start Snapshot

H History Control Table{17) x|

|tilization || Packet Type Etror Type | Custom

Ertry | Table | Plot Chert | Pie Chart  Options |
| 8

~Polling Interyal:

Palling Interyal: |20 ﬂ % zec  { min

~Display data type of chart:

" Apszolute Walue (% Per Sample " Per Second

Regizt menu |

Save polling data |

Start shapshot |
Part17: 100 Mbps  |Polling Interval: 20 ... In Palling Per Sample
Inclex: 17 Data Source: ifinde... | Owner: monitar Status: walid

Close

RMON Options tab (History Control Parameters)

7.3.7.1 Polling Interval

You can change the polling interval here.
7.3.7.2 Display data type of chart

Specifies how to display data in graphs and charts. You can select one of the following
options.

Because RMON histories are collected by RMON agents and Device Manager only displays
the collected data, settings here are slightly different from other windows. The Polling

Interval here is simply the interval at which Device Manager gets collected data from
RMON agents.
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Absolute Value
Displays the sum of values which Device Manager got from the RMON agents, as
shown in the following example.

Data sampled by RMON Data displayed by Device Manager

Sample | 100 100

Sample 2 50 150

Sample 3 250 400
Per Sample

Displays data which Device Manager got from the RMON agent as it is.

Data sampled by RMON Data displayed by Device Manager

Sample | 100 100

Sample 2 50 50

Sample 3 250 250
Per Second

Displays "Sampled data / Sampling Interval configured on the RMON agent". The
sampling interval here is the RMON agent's sampling interval, not the interval
configured in Device Manager. In the following example, the RMON agent's sampling
interval is 10 seconds.

Note - Calculated values are rounded. For example, the Number of Error packets is
usually very small so that the calculated value is likely to be zero.

Data sampled by RMON Data displayed by Device Manager

Sample | 100 10 (100 / 10)
Sample 2 50 5(50/ 10)
Sample 3 250 25 (250 / 10)

7.3.7.3 Regist Menu

Add this window to the user-defined User Menu.

7.3.7.4 Save Polling Data

This button opens the Polling Data Save dialog box, used to save collected data to a file.
Specify the name and format of the file in which the data is to be saved. Select a file format
from the options below. To start saving the data, click OK.

When you start saving data, the button's label changes to "Saving polled data". To close the
file and stop saving the data, click the "Saving polled data" button.

CSV Format
Saves the data in comma-separated values (CSV) format.

TAB Format
Saves the data in tab-separated values (TSV) format.
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Note - Only the values of the collected RMON variables are saved. Values Device Manager
calculates from these collected values are not saved.

7.3.7.5 Start Snapshot

Clicking this button opens the Start Snapshot window. Use this window to create an image
of the device, as well as tables or charts representing device information, in HTML format.
Use the 'Browse' button to select the directory or folder where you want to save the image.

Note - You can generate an image of the main panel, table data, or charts. The type of image
or device information that you can generate depends on which menu you opened the Start
Snapshot window from. For more information on the file types created in the Start
Snapshot window, see section 5.2.6.

HH start Snapshot |
File natme: Isﬁ.&llied Telesiz\aliedview -EMStmpishapshot bitm Erowese. .. |
Select:

[V hiain panel

[ Takle dats I Pict chart
[T Bar chart V¥ Fie chart

[¥ Reload
Fareground Colar, ———————— Eackground Colar:

. Color selection | Color zelection
[0].4 | Cancel I

Start snapshot
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Below is a snapshot from the RMON History Control Parameters window, with the main
panel and table data marked in the Start Snapshot window:

3 192.168.10.56 - Device Manager for AT-8224XL: History Control Table{historyControlEntry.1} - Microsoft in 0

e ER vew o Dok b @

@Backr@v@ @ﬁ|pm sf@wamm @|@v% 'D%ﬂ

Address | C:{Program Fies\alied Telesisialisdiiew EM5tmptsnapshot.htm ] oo s >

57 - 2| v || search web |r|ﬁv| (11 Bockmarks ...sktemping to retrieve buttans from Yahoal ..
192.168.10.56 - Device Manager for AT-8224XT, =

History Control Table(lustoryControlEntry.1)

2005/0512 145738

Front Panel

Table
Eﬂf‘mﬁ]ﬁf 77912790 89 2788 2787 2786 2785 2784 278327
i:;;;ﬁﬁim) o b o o b b o ool b o
i:;;;;”ﬁ) o b o bbbl b
Unicast Packets o o o b oo oo oo o o [o
€] one [T T T [ vy Computer 4

RMON History Control Parameters snapshot
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7.3.8 Close

Closes the RMON History window.

7 RMON
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7.4 Alarm Table

From the Alarm Table menu, you can view and edit the RMON Alarm table on the RMON
agent. RMON Alarm table is used to monitor a specific variable by setting a threshold on
the variable and by specifying an event action to be taken if the threshold is reached.

The Alarm Table is not automatically updated. To see the latest information, click the
Refresh button.

Topics:

e Alarm Table Tab

o Event Table of Alarm
¢ Add Button

o Edit Button

¢ Remove Button

e Close

i Alarm/Event Table

Alarrn Table | Event Table | Event Log

| 2|or| x|

Alarm Tahle

Index | Sampl... | Sampling MIBE Va...| Sam... | Sa... | Stadu... | Riging T...| Falling ...| Rizin... | Fallin... | Status | Cwner

1 etherstat=Phktz A celtta ... 2 2 2w
2 1 |etherStatzPkis 1 delta ... Olrising a... 1 1 1 0 walicl Allied. ..
3 3letherStatzPiis i delta ... Olrizing a... 2 2 3 0 walicl Allied... LI

Event Takle of Llarmg#

In...| Event Descript... Ewvert Type TRAP Co... | Last Sent Event Time Status Oy et |
1|Rizing Event fa... |none public 0 clays 0000:00 Q00 |wealid Alliedview-EMS Device Ma..
2|Falling Evert fo... log public 0 days 000000 000 |valid Alliediew -EMS Device Ma...

Cloze

RMON Alarm Table tab
7.4.1 Alarm Table Tab
The Alarm Table shows the list of currently defined alarm entries.

Index
The index number used to identify this alarm entry.

Sampling Interval
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The time interval at which the RMON agent samples data.

Sampling MIB Variable Name
MIB variable to be monitored. The object type must be one of INTEGER,
COUNTER, GAUGE and TIMETICKS.

Sampling Type
How to compare the sampled value with the threshold. "absolute value" means
comparing the sampled data with the threshold without modification. "delta value"
means comparing the difference between the latest sampled value and the previous
sampled value with the threshold.

Sampling Value
The last sampled value.

Startup Alarm Type
The type of threshold which is applied to the first sampled value after this Alarm
entry becomes valid.

rising alarm
A single RMON event is triggered if the first sampled value is greater than or equal
to the configured rising threshold.

falling alarm
A single RMON event is triggered if the first sampled value is less than or equal to
the configured falling threshold.

rising or falling alarm

A single RMON event is triggered if the first sampled value is greater than or equal
to the configured rising threshold, or if the first sampled value is less than or equal
to the configured falling threshold.

Rising Threshold
The ceiling threshold.

Falling Threshold
The floor threshold.

Rising Event Index
The index of the RMON Event entry which is triggered when the sampled value
rises above the rising threshold.

Falling Event Index

The index of the RMON Event entry which is triggered when the sampled value falls
below the falling threshold.
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"Event Table of Alarm" shows a list of events for the Alarm entry which is selected in the
Alarm Table. You can check which type of events are configured for a specific alarm entry.

Index
The index number used to identify the Event entry.

Event Description
Text describing the Event entry.

Event Type
The type of action to be taken if the event occurs. Select one of "none" (no action
taken), "SNMP trap" (send out an SNMP trap), "log" (record to the log) and "log &
SNMP trap" (record to the log and send out an SNMP trap).

TRAP Community
Trap Community name.

Last Sent Event Time
The value of sysUpTime at the time when the last event occured.

Status
The status of the Event entry.

Owner
The owner (creator) of the Event entry.

7.4.3 Add Button

=: adds a new entry to the table. Click this button to open the Add Alarm Table Entry
dialog box, enter parameters for the Alarm Table entry, and click OK to add the new entry.

Note - If you specify an SNMP trap action, trap hosts must be configured in the RMON
agent. Trap hosts cannot be configured by Device Manager. Use other means, such as a
console terminal, Telnet or Web interface to set up SNMP trap hosts on the agent.

Note - If you configure the station running Device Manager as the trap host, use the same

Trap community name configured in the Target Host Property dialog box (File >
Properties).
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Add Alarm Table Enktry
&l
Incle: Sampling Intersyal: |3III

et

Sarmpling MIE “ariable M... letherS‘tatsF'k‘tsj

LI Sampling Type:

Iderta value

=l

IAIIiedViEW-EMS Device Manager - £ Startup Alarm T... Irising or falling ... LI

~Rizing Alarm Event Rule:

Riging Threshold:
Rizing Event Index:

Event Dezcription:

000 Ewvent Type:

i

=l

TRAP Comrrunity:

IRising Ewvert far &larm#

~Falling Alarm Event Rule:

Falling Threshold:
Falling Event Inde:x:

Ewvert Description:

2000 Evert Type:

[

TRAP Cormtrunity:

|Faling Evert for Alarma1

[0].4 | Cancel I

Add Alarm Table Entry dialog box

Alarm
Index

The index number used to identify this Alarm entry. By default, the lowest unused
number is automatically displayed. If you explicitly specify a number currently in use,
that entry will be overridden.

Sampling Interval

The sampling interval in seconds.

Sampling MIB Variable Name

Type or select the name of the MIB variable to be sampled.

Sampling Type

How the sampled value is compared with the threshold. "absolute value" compares
the sampled data with the threshold without modification. "delta value" compares
the difference between the latest sampled value and the previous sampled value with

the threshold.
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Owner

The owner (creator) of the Alarm entry. By default, "AlliedView-EMS Device
Manager - station name" is used where "station name" represents the host name of
the station on which Device Manager is running.

Startup Alarm Type
The type of threshold which is applied to the first sampled value after this Alarm
entry becomes valid.

rising alarm
A single RMON event is triggered if the first sampled value is greater than or equal
to the configured rising threshold.

falling alarm
A single RMON event is triggered if the first sampled value is less than or equal to
the configured falling threshold.

\ rising or falling alarm
A single RMON event is triggered if the first sampled value is greater than or equal
to the configured rising threshold, or if the first sampled value is less than or equal
to the configured falling threshold.

Note - The Startup Alarm Type is only applied to the first sampled value. From the
second sampled value, both the rising and falling thresholds are effective regardless
of the Startup Alarm Type. If only one type of threshold is significant, set the "Event
Index" for the Alarm type that is not required to 0. For example, if you want to
monitor only the rising threshold, set the Falling Event Index to 0. No event occurs
for an Event Index of 0, even if the values reach the threshold.

Rising Alarm Event Rule
Configuration for the rising alarm. If you select "falling alarm" for the Startup Alarm
Type, only "Rising Threshold" and "Rising Event Index" can be configured. If there is
no Event entry corresponding to the Event Index, no event will occur.

Rising Threshold
The ceiling threshold. If the monitored variable exceeds this threshold, the rising
alarm is invoked. The default is 3000.

Event Type
The type of action to be taken when the event occurs. Select one of "none" (no
action taken), "SNMP trap" (send out an SNMP trap), "log" (record to the log) and
"log & SNMP trap" (record to the log and send out an SNMP trap).

Rising Event Index
Index of the RMON Event entry which is triggered when the sampled value reaches
the rising threshold. If you select "falling alarm" for the Start Alarm Type, this
defaults to zero. Because an Event Index of 0 is invalid and there is no event related
to Index 0, no event will occur even if the rising alarm is triggered.
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TRAP Community
Trap Community name.
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Event Description
Text string describing the event. By default, "Rising Event for Alarm#idx" is used
where "idx" represents the Alarm index number-.

Falling Alarm Event Rule
Configuration for the falling alarm. If you select "rising alarm" for the Startup Alarm
Type, only "Falling Threshold" and "Falling Event Index" can be configured. If there is
no Event entry corresponding to the Event Index, no event will occur.

Falling Threshold
The floor threshold. If the monitored variable falls below this threshold, a falling
alarm event occurs. The default is 2000.

Event Type
The type of action to be taken when the event occurs. Select one of "none" (no
action taken), "SNMP trap" (send an SNMP trap), "log" (record to the log) and "log &
SNMP trap" (record to the log and send an SNMP trap).

Falling Event Index
The index of the RMON Event entry which is triggered when the sampled value falls
below the falling threshold. If you select "rising alarm" for the Start Alarm Type, this
defaults to zero. Because an Event Index of 0 is invalid and there is no event related
to Index 0, no event will occur even if falling alarm is triggered.

TRAP Community
Trap Community name.

Event Description

Text string describing the event. By default, "Falling Event for Alarm#idx" is used
where "idx" represents the Alarm index number-.

7.4.4 Edit Button

[¥': edits the selected Alarm entry. Click this button to open a dialog box, specify options,
then click OK. You can also open this dialog box by double-clicking the entry.

7.4.5 Remove Button
#: removes the selected Alarm entry.
7.4.6 Close

Closes the window.

7 RMON
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From the Event Table menu, you can view and edit the RMON Event entries. The data is
not automatically updated. Use the Refresh button to view the latest information.

Topics:

o Event Table Tab
o Select Button

e Add Button

o Edit Button

¢ Remove Button

o Close
Alarm;/Event Table x|
&larm Table  Evert Table | Everit Log I
| 8+ | xS
Ewent Tahle
Incex I Event Descrigtion Event Type TRAP Co.. | Last Sent E... Status Chvher
1|Rizing Event for Alarm#1  |honelnone) public 0 days 000 valid(valicd) | Aliedyiew-EMS |
2|Falling Event for Alarm#1 |logllog) public 0 days 000 valid(valicd) | Aliedyiew-EMS |
3|Rizing Event for Alarm#7  |logllog) public 0 days 000 valid(valicd) | Aliedyiew-EMS |
4 |[Evert for Alarmd SMMP trapisnmp-trap) (public 0 days 000 [validivalid)  [&lliediew-EMS ...
o [Evert for Alarm# SMMP trapisnmp-trap) (public 0 days 000 [validivalid)  [&lliediew-EMS ...
B [Rizing Event far Alarm#s |nonenone) pukilic O days 000 [validivalid)  [Aliediew-EMS ...
7 [Rizing Event for Alarm#&E |SKMP traplsnmp-trap) [public 0 days 000 [validivalid)  [Aliediew-EMS ...
g|Falling Event for Alarm#5 |noneinone) public 0 days 000 [validivalid)  [Aliediew-EMS ...
3(Evert for Alarmd SHMP traplsnmp-trap) |public O days 000 [validivalid)  [AliedYiew-EMS ...
RMON Event Table window
7.5.1 Event Table Tab
The Event Table shows the list of all currently configured Event entries.
Index
The index number used to identify the Event.
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Event Description
Text describing the Event entry.

Event Type
The type of action to be taken when the event occurs. Select one of "none" (no
action taken), "SNMP trap" (send an SNMP trap), "log" (record to the log) and "log &
SNMP trap" (record to the log and send an SNMP trap).

TRAP Community
The Trap Community name.

Last Sent Event Time
The value of sysUpTime at the time when the last event occured.

7.5.2 Select Button

@ sclects an Event entry to be displayed in the Event Log tab. In the Event Log tab, only
log entries related to the selected Event Index are displayed.

7.5.3 Add Button

=k creates a new Event entry. Click this button to open a dialog box for a new entry.
Specify options, then click OK to add the new entry to the table.

 add Event Table Enkry X

Evert Index: |4

Ewvent Type: ISNMF‘ traplsnimp-trap) LI

TRAP Cormtrunity: Ipublic

Ewvent Descrigtion: IEvent for Alarm#

Cryyrier: IAIIiEdViEW-EMS Device Manager - Administrator

034 Cancel

Add Event Table Entry dialog box
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7.5.4 Edit Button
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[¥': edits the selected Event entry. Click this button to open the Edit dialog box for the
selected entry. Change the configuration, then click OK to modify the entry. You can also
open this dialog box by double-clicking the entry.

7.5.5 Remove Button

#.: removes the selected Event entry.

7.5.6 Close

Closes the Event Table window.

7 RMON
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7.6 Event Log

From the Event Log menu, you can view and remove RMON event log entries. Log entries
displayed on the screen are not automatically updated. To view the latest log entries, click
the Refresh button.

Topics:

o Log List of All Events
e Event Log Entry

o Remove All Button

¢ Remove Button

o Display All Button

o Refresh Button
e Close

- alarm/Event Table

Alarm Table I Event Table Ewvent Log |

| Bl =]
Log List of &ll Events
Ewent Index | Index | Log Time Log Description
1 1 tddays 92300430 1.361.21.221.17.25¢
1 2 14days 93247170 1.2.61.21.2.21.17.25¢
1 3 14days 9:35:02590  1.3.61.21.221.1°.25¢
1 4 1ddays 93547710 1361212211725
1 8 1ddays 936:47 890 1.361.21.221.17.25¢
1 B 14days 9:32:48 250 1.32.61.21.2.21.1°.25¢
1 7 14days 9:41:43800 1.3.61.21.2211°.25¢
1 2 1ddays 9:44:49 350 136121, 22117 2564
1 9 1ddays 94749900 1.361.21.221.17.25¢
1 10 14days 950:60 390 1.3.61.21.2.21.1° 251
1 11 14days 954:05 930 1.3.61.21.221.17.25¢
1 12 14days 3:86:21 420 1.361.21.2.211°.24

Cloze

RMON Event Log tab
7.6.1 Log List of All Events
This table shows a list of all log events which occurred.
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Event Index
The index number of the Event table for this log entry.
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Index
The index number used to identify this log entry.

Log Time
The time when this log entry was recorded.

Log Description
Text describing the log entry.

7.6.2 Event Log Entry

By double-clicking the log entry, the following Event Log Entry dialog box appears.

HH Event Log Entry

Event Index: Log Index:
|1 4

Log Time:
|14 daws 3230147 710

Log Description:

LB 2.201.11.28 (delta = 8, Rising Threshold = ;I
2, interval = 30)[alarmIndex. 11 Rizing Event for
dlarmfl”

[

Event Log Entry dialog box
7.6.3 Remove All Button
"% clears all log entries.

7.6.4 Remove Button

X clears log entries that have the selected Event Index. You can select any one of the
entries which have the same Event Index number.

7.6.5 Display All Button

E. displays all event log entries. It may take some time to display all entries.
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7.6.6 Refresh Button
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2 displays the latest log table. The log entries are not automatically updated.
7.6.7 Close

Closes the Event Log window.

7 RMON
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8 Forwarding Database

The Forwarding Database option under the Bridge menu allows you to view the FDB
(Forwarding Database) Table containing unicast entries for which the bridge has forwarding
and/or filtering information. AlliedView-EMS provides two ways of viewing the FDB Table:
Standard View and Enhanced View.

Topics:

e Standard View
e Enhanced View

8 Forwarding Database
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8.1 Standard View

The Standard View allows you to view the FDB Table as returned by the device. This is the
default view that is available across all devices that support transparent bridging.

FDE Table Parameters x|

Table | Bt | options |

| Bl
MAC Address . Port Murnber Eritry Status
[ 000029 04 24 EB 23 leatred -
0000 Ch o0 &0 33 11 learred j|
00 00 CC 03 39 BO 23 learned
0000 Ch 04 00 12 16 learned
00 00 CO 05 46 DO 13 learned
0000 Ch 03 EA E4 11 learned
0000 Ch 10 C3 90 2 learned
0000 CD1E 58 7B 9 leatred
0000 ch18 38 95 5 leatred
0000 cCD198F 73 5 learned
0000 CD 10 03 EF 1 learned

o000 CoD 1A CE 11 learned 7
4 I I ]

Standard View

8 Forwarding Database

AlliedView™-EMS 3.11 Device Manager User’s Guide Page 128 of 130



\—/ _
AVE Allied Telesis

8.2 Enhanced View

The Enhanced View allows you to select a port or group of ports to view its corresponding
FDB Table entries. It also displays the total number of FDB Table entries associated with
the selected ports. This view is available only for selected devices with at least |6 ports.

x|
Tabie |
Learned MAC Addresses on Selected Portis): 91
PortMumber - | MAC Address | Ertry Status |
1 0009 6B 1205 66 leatrned -
1 0010 BS AL BF 2F leatrned
1 0010 ES A8 A7 7S leatrned
1 0010 BS B0 ES D4 leatrned
1 0011 2F DC 52 80 learned
1 0041 2F DC 82 95 learred
1 0041 2F DC 52 94 learred
1 o041 2F DC 82 B3 learred
1 0080 A0 52 90 EG leatrred
2 000 Coq0C3 90 learred
3 oooochM TCFB learned
3 0000 Co 24 DA DS leatned
= 0000 Ch 15 35 95 leatned
= 0000 Ch 19 8F 73 leatned
= 0000 Co 24 FE 26 leatned jJ

Enhanced View

FDB Table entries are initially sorted in ascending order based on the Port Number field.
To sort based on a different field, click on the column heading of the desired field. Clicking
on the same column heading repeatedly will cause the table to sort alternately in ascending
and descending order.

8 Forwarding Database
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